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Introduction
Learning Objectives
Upon completion of this lesson you will be able to: 

Understand the importance of Parent/Child relationships.
Review the model creation steps.
Modify the design using the Define in Work Object command.
Organize the features of the model into various bodies and geometrical sets.

4 Hours

1
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Case Study

The case study for this lesson is the Hinge.

Design Intent

The Hinge is a molded part that is used in 
an assembly.
The part is symmetrical.
The holes are centered on the bearings.

Stages in the Process
1. Review the User Interface. 
2. Understanding importance of Parent/Child Relationships.
3. Organizing a Model.

X-section of handle block

XY plane
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CATIA is mechanical design software. It is a 
feature-based, parametric solid modeling design 
tool that takes advantage of the easy-to-learn 
Windows graphical user interface. You can create 
fully associative 3D solid models with or without 
constraints while utilizing automatic or user-defined 
relations to capture design intent.

Review the User Interface

The Part Design workbench lets you build solid 
3D geometry. From the Part Design workbench 
you can access the Sketcher workbench and 
create 2D profiles that will become 3D model.
The Assembly Design workbench allows you to 
bring components together to create the final 
product. You can design parts in the assembly 
context and use methods of designing 
assemblies that will aid in concurrent 
engineering, such as Skeleton models and 
publishing elements.
The Generative Shape Design workbench lets 
you create surface and wireframe geometry. 
The surface and wireframe geometry allows you 
to create more complex solid models and gives 
more control over the shape of a model.
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Importance of Parent/Child Relationships (1/2)

Bottom Reference Plane

Top Reference Plane

1

2

3

4

Design intent is a plan to construct solid model of a 
part, in order to convey its visual and functional 
aspects. The way a solid model is built can affect 
many aspects, including its flexibility to changes, its 
stability during the change process, and the resource 
requirements to compute a new result. Therefore, it is 
important to take the design intent into account to 
achieve an efficient solid model of the part.

The dependency between one feature and the other 
is known as a parent/child relationship. Parent/Child 
Relationships are important in maintaining the design 
intent of the part. You should carefully consider 
choosing the best base feature, which parent/child 
relationships should exist, and what dimensions and 
feature order best reflect the planned design intent.
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Importance of Parent/Child Relationships (2/2)

Many design practices are derived from company 
standards and need to be considered before 
modeling. Some common design practices are:

Always choose the most stable feature in the 
model as the base feature.
Try to avoid creating references to dress-up 
features such as fillets and chamfers. These 
features may be removed in downstream 
applications.
Choose the best depth option for the application. 
For example, decide if a pocket is required to cut 
through the entire model. Creating the pocket with 
a dimensional depth is not recommended, 
because the depth of the feature it is cutting 
through may change; instead, create the pocket 
with an Up to Last depth.

The upper Pad Sketch is
created on reference Plane 
and independent on the
Base Pad.

The Pocket Sketch is
created on reference Plane
and independent on the 
Upper Pad.

On deletion of the Upper Pad, the pocket is not 
affected.
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Main Tools / Menus (1/2)

1

1 Scan or Define In Work Object: Helps you 
review how the model was created, feature by 
feature. 

Investigating the Model

2

2 Parent/Children: Displays the parent and 
children of the selected feature and hence 
helps to display the relationships that exist in 
the model.

3 Define in Work Object: Activates the current 
selected feature disabling all child features. 
You can use Define in Work Object to review 
the feature, edit it or modify the design.

3



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 13

Main Tools / Menus (2/2)

1 Body : Inserts a new body feature in the part.

Organizing a Solid Model

2 Geometrical Set: Inserts a new Geometrical 
Set in the part.

3 Ordered Geometrical Set: Inserts a new 
Ordered Geometrical Set in the part.

4 Hybrid Design Option: You can chose to 
embed hybrid design in your part by activating 
the Enable hybrid design inside part bodies 
and bodies option by accessing Tools > 
Options > Infrastructure > Part Infrastructure 
> Part Document.

1

2

3

Tools > Options Setting

4
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Case Study: Introduction
Recap Exercise

40 min

In this exercise you will create a model. The skills needed to create this model 
were covered in the Fundamentals course. There are no detailed instructions for 
this exercise. Instead a detailed drawing has been provided for your reference.
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Case Study: Hinge

Bearing

Hole

Bearings

Holes

• The Hinge is a molded part that is used in an assembly.
• The part is symmetrical.
• The holes are centered on the bearings.

Before you begin to design the model you must analyze what is the best base feature? Which 
features will make good parent features? Which features will not make good parent features? 
What is the best orientation of the model? Which reference plane will you choose as the 
sketch support for the base feature? How will you constraint the base feature?

Consider the following:
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Do It Yourself: Hinge (1/3)
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Do It Yourself: Hinge (2/3)

21

6

5

43

1. Create the base feature.
2. Create the pocket.
3. Create a second pad feature.
4. Create a user pattern.
5. Apply fillets.
6. Apply drafts.

The following is a suggested method to design 
the Hinge:
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Do It Yourself: Hinge (3/3)

7
8

9

10

The following is a suggested method to design 
the Hinge (continued):

7. Create second set of fillets
8. Mirror the model.
9. Create hole.
10. Create a user pattern.
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Case Study: Hinge Recap

Determine the best base feature.
Determine the best orientation.
Determine which parent/child relationships 
should be created and which should be 
avoided.
Determine the best way to organize the 
model.





CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 21

Design Complex Parts
Learning Objectives
Upon completion of this lesson you will be able to

Create Advanced Sketch-Based Features.
Multi Section solids.
Create advanced Drafts.
Advanced Dress-Up features.
Use the Multi-Body Method.
Create Multi-Model Links.

2

8 Hours
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The case study for this lesson is the Bottom Cover of 
a CD jewel case.

Design Intent

Stages in the Process
1. Create advanced sketched-based features. 
2. Create dress-up features.
3. Use the Multi-Body method.
4. Create Multi-Model links.

Base feature must include overall dimensions 
supplied. Two sketches outlining the overall shape 
of the model are supplied to create a solid combine.
Create each support as a single feature.
Create a cut to simulate the logo using a removed 
multi-sections solid.
By linking to disk holder and flex opening models, 
any changes that occur in the original source files 
will update in this file.
Linked features must be kept in separate bodies.
Do not display indented logo when it goes for 
manufacturing.

Case Study
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Create Advanced Sketch-Based Features

Ribs and slots are created by sweeping a profile 
along a center curve. 

A Solid Combine feature is created by the 
intersection of two components. These can be:

Sketches
Surfaces
Sub-elements of sketches
3D Planar curves

Rib

Slot

Solid Combine

Profile 1
Profile 2

The advanced dress up features are:

Create Advanced Dress Up Features

1. Thickness: Adds an over thickness to a face; 
used before machining the part.

2. Remove Faces: Used to simplify the geometry 
for downstream applications e.g. machining.

3. Replace Faces: Used to replace the planar solid 
surface with the surface.

1

2

3
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Create Advanced Draft 

Draft using a Parting element

Parting Element
While creating advanced drafts, the parting 
element can be selected. A Parting line represents 
the location where two halves of the mold meet.

A Parting element can be a line, surface or a face.

Advanced Drafts can be used to create basic line 
and reflect line drafts as well as drafts with two 
different angle values for complex parts.

Different types of advanced Drafts are possible:

1. A Standard draft with one side draft
2. A Standard draft with two sides draft
3. A draft using a reflect line
4. A draft using two reflect lines

1 2

3 4
3
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Create Multi-Sections Solids (1/2)

A Multi-Sections solid can be positive (i.e., add 
material) or negative (i.e., subtract material). It is 
generated by two or more planar profiles swept along 
a spine. 

Profile 1: Rectangle

Profile 2: Hexagon

Various types of Multi-Sections Solid are:

1. Simple Multi-Sections Solid: The selection order 
of the sections controls the shape of the result. 

2. Multi-Sections Solid using Guide curve: The 
guide curves control the shape of the solid 
between the profiles. They must intersect the 
profile.

3. Multi-Sections Solid using Spine: The spine 
curve controls the shape of the features 
between the profiles.

4. Multi-Sections Solid Tangent to adjacent 
surfaces: The multi-sections solid is tangential 
to the adjacent solids / surfaces. Here the multi-
sections solid acts as a transitional feature.

Guide 1

Guide 2

1 2

3 Spine 4
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5. Multi-Sections Solid using Couplings: The curves 
are coupled according to different criteria. These 
are as follows:
a. Ratio: The ratio of each section’s length.
b. Tangency: Uses tangency discontinuity 

points.
c. Tangency then Curvature: uses the tangency 

discontinuity points first and then later the 
curvature discontinuity points.

d. Vertices: Uses the section’s vertices.
e. Manual coupling: Used when various 

sections do not have the same number of 
vertices.

6. Multi-Sections Solid using Relimitations: By 
clearing the Relimitation options in the 
Relimitation tab, the result can be extended to 
the length of the spine or the guide curves.

5

6

Create Multi-Sections Solids (2/2)

Closing Point and Direction is
correct

Closing Point selected is 
incorrect

Recommendations to avoid twisted surfaces:

Choose appropriate Closing Points.
Keep consistent directions.
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Use the Multi-Body Method

The Multi-Body Method allows you to design a 
complex part using simple bodies. Each body acts 
independently in the model. The final part is 
obtained by combining these bodies using Boolean 
operations.

PartBody Body.2 Body.3 Body.4
The advantages of using the Multi-Body method 
are as follows:

It provides an organized approach to modeling 
complex parts.
Solid features within a body can be hidden 
independently of the rest of the model.
Groups of geometry can be de-activated by    
de-activating the body.
Complex geometry is easier to create within a 
focused area of the model.
The model will update faster due to the 
organized structure.
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Boolean Operations

A

B
C

Part Body

Body 2

Part Body
Body.2

D

Part Body
Body.2 E

Faces to be 
removed F

A. Assemble: The result will depend on the 
polarity of Body.2. A negative feature (pocket 
or groove), will remove material from the 
PartBody, a positive feature will add material.

B. Add: A union of Body.2 and PartBody. 

C. Remove: Body.2 will cut PartBody.

D. Intersect: The resulting solid is the material 
common to the intersecting elements.

E. Union Trim: This operation is a union of the 
two bodies with the option to remove or keep 
selected faces.

F. Remove Lump: A lump is material that is 
completely disconnected from the remainder 
of a single body, and may appear after 
certain operations. This operation is used 
select the faces to remove. 
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The use of Multi-Model Links enable you to design a 
model using elements from another model. This will 
enable you to update the part automatically if 
changes occur in the source model. To create links:

1. Copy a body in the source model.
2. In the target model, right-click on the Part and 

click Paste Special from the contextual menu.
3. Select As Result with Link. The Source 

PartBody is copied into the target model.
4. Complete the target model with the new body.
5. Modify the source model.
6. The target model is updated to take into 

account changes to the source model.

It is recommended that copied 
elements be published. The shared 
geometry can be restricted
to published elements only.

Create Multi-model Links

Choose the Paste Special option that best meets your 
design requirements:

As Specified in the Part Document: The copied elements 
can be edited separately in the target part. A surface 
cannot be pasted in this way.
As Result: The copied elements cannot be edited in the 
target part and are not linked to the source part.
As Result with Link: The copied elements cannot be 
edited in the target part but are linked to the source part. 
A geometrical set cannot be pasted in this way.

1
2

3

4

5
6

Note: If you copy a geometrical 
set and select the PartBody for 
the paste the geometrical set 
will be inserted under the Part 
Body and NOT at the same level 
as the PartBody.
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1

2

3

4

Rib: Creates a positive solid from a profile 
swept along the center curve.
Slot: Creates a negative solid from a profile 
swept along the center curve.
Solid Combine: Creates an intersection solid 
from the two extruded profiles.
Multi-sections Solid: Creates a positive solid 
joining multiple sections.
Remove Multi-sections Solid: Extrudes a 
solid up to a surface.
Advanced Draft: Creates a basic line and 
reflect line drafts with two different draft angles 
for complex parts.
Thickness: Adds / Removes thickness to a 
selected face or a surface.
Remove Face: Removes selected faces to 
simplify the geometry for finite element analysis 
/ downstream applications.
Replace Face: Extrudes a solid up to a surface.

Advanced Sketch Based Features

5

Main Tools (1/3)

6

7

8

9

1

2

3

4

5

6

7

8

9
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10

11

12

13

Assemble: Creates a union of two bodies, the 
union respects the true nature of the bodies. 
(Positive features add material, negative 
features remove material).

Add: Creates a union of two bodies.

Remove: Removes selected body from the 
PartBody.

Intersect: Creates an intersection solid from 
the selected bodies.

Union Trim: Creates an intersection solid from 
the selected bodies with an option to remove or 
keep one side.

Remove Lump: Removes selected faces 
(lumps and cavities).

Boolean Operations

14

15

10

11

12 13

12

13 14

15

Main Tools (2/3)
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16

17

Copy: Copies the selected features.

Paste Special: Pastes the selected features 
into the destination. 

Multi-Model Links
16

17

Main Tools (3/3)

As specified in 
Part Document

As Result

As Result With Link

As Result
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Exercise: Rib and Slot
Recap Exercise

15 min

In this exercise, you will create a new model and use the tools learned in the lesson 
to create a rib and a slot feature. High-level instruction is provided for this exercise.

By the end of this exercise you will be able to:

Create a Rib Feature

Create a Slot Feature
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Do it Yourself (1/4) 

1. Create a new part file. 
• Create a new part file called Ex8B. 

2. Create the center curve sketch.
• Create a positioned sketch as shown for the 

center curve.
• Rename the sketch to [Center Curve].
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Do it Yourself (2/4) 

3. Create a reference plane.
• Create an offset plane as shown. 

4. Create a profile sketch for the rib.
• Create a positioned sketch as shown for 

the rib profile.
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Do it Yourself (3/4) 

5. Create the rib feature.
• Use the center curve and profile sketch to 

create a rib feature.

7. Create a profile sketch for the slot.
• Create a positioned sketch as shown for 

the slot profile.  
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Do it Yourself (4/4) 

8. Create a slot feature.
• Create a slot feature using the sketch 

created in the last step as the profile and 
the Center Curve sketch as the trajectory.  

9. Close the file without saving it.
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Exercise Recap: Rib and Slot

Create a rib

Create a slot
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Exercise: Rib and Multi-section Solid
Recap Exercise

30 min

In this exercise, you will open an existing model and use the tools learnt in the lesson 
to create rib and Multi-sections Solid features. High-level instruction is provided for 
this exercise.

By the end of this exercise you will be able to:

Create a Rib Feature

Create a Multi-sections Solid Feature
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Do it Yourself (1/7) 

1. Open the existing part file. 
• Open Wrench.CATPart. Notice some 

features have already been created.
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Do it Yourself (2/7) 

2c

2d

2. Create a rib.
• Use Sketch.13 as the profile for a rib feature.

a. Access the Rib Definition dialog box.
b. Select Sketch.13 as the profile.
c. Right-click the Center Curve field and 

click Extract from the contextual menu.
d. Select the edge shown. Can the feature 

be created? Why not?

2b
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Do it Yourself (3/7) 

2f

2g

2. Create a rib (continued).
e. Select the Thick Profile option.
f. Type [4 mm] in the Thickness1 field.
g. Complete the feature.
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Do it Yourself (4/7) 

3

4

3. Create a profile for the multi-sections solid. 
• Create the profile as shown using the lower face 

of the pad as the sketch support.

4. Create a second profile for the Multi-
sections solid.
• Create a reference plane offset [7mm] from the 

lower surface of the pad. Create the sketch 
shown using the reference as the sketch 
support. The diameter of the sketched circle is 
[14.4mm].

• The sketch is created on a user-defined plane. 
After the plane is created, if you do not re-
activate the PartBody, the sketch will be created 
in Geometrical Set.1. Move the sketch back to 
the PartBody by clicking Change Geometrical 
Set from its contextual menu, and select the 
PartBody from the specification tree.
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Do it Yourself (5/7) 

5. Create a multi-sections solid.
• Use the profiles and the lower surface of 

the shaft feature as the profiles for the 
feature. Notice that the feature is 
automatically tangent to the shaft.
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Do it Yourself (6/7) 

6. Create a second multi-sections solid.
• Create a second multi-sections solid to 

complete the handle. Use appropriate 
surface of the shaft, sketch.4, sketch.5, and 
sketch.6 as the profiles. Use Spine.1 and 
Symmetry.1 as guide curves for the feature.
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Do it Yourself (7/7) 

7. Create a pocket feature.
• Create a pocket feature to trim away the 

excess material from the top of the 
wrench. Use the XY plane as the sketch 
support for the pocket feature.

8. Clarify the display, save, and close the 
model.
• Hide all wireframe and surface elements. 

Save and close the model.
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Exercise: Rib and Multi-Section Solid Recap

Create a rib

Create a multi-sections solid
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Exercise: Advanced Draft
Recap Exercise

20 min

In this exercise, you will open an existing part that contains sketched wireframe 
elements and a surface feature. To complete this model you will have to create 
several advanced draft features. You will also use pads, variable fillets, and the mirror 
operation to complete this model. High-level instruction is provided for this exercise.

By the end of this exercise you will be able to:

Apply advanced draft features
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Do it Yourself (1/6) 

1. Load Ex8F.CATPart.

2. Create a pad Feature.
• Use Sketch.1 to create a pad feature with 

a depth of [20mm].
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Do it Yourself (2/6) 

3b

3c

3a

3. Create a draft.
• Create draft on the outside vertical 

wall.
a. Use a draft angle of 2 degrees.  
b. Use the positive Y direction as 

the pull-direction.
c. Use the right vertical face as the 

neutral plane.
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Do it Yourself (3/6) 

4. Create a variable radius fillet.
• Apply a variable radius fillet to the 

top and bottom outside edges. 
Create the fillet from [4mm] to [6mm] 
along each side.
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Do it Yourself (4/6) 

5c

5a

5b

5f

5d

5e

5. Create an advanced draft.
• Create a two-sided reflect draft.  

a. Use the Driving/Driven
dependency option.

b. Set the draft angle to 4 degrees.  
c. Use the XY plane as the pulling 

direction for the first side. 
d. Use the top fillet as the neutral 

element for the side one.  
e. Select the Extruded surface as the 

parting element. 
f. Use the bottom fillet as the neutral 

element for the side two.
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Do it Yourself (5/6) 

7

6
6. Create two pad features.

• Use Sketch.2 to create a pad feature 
with a depth of [30mm].

• Use Sketch.3 to create a pad feature 
with a depth of [50mm].

7. Apply an advanced draft.
• Apply an advanced draft feature to 

the two pads.  
a. Create the draft with a 4 degree 

draft angle on the first side.
b. Use the XY plane as the pulling 

direction for side one.
c. Use a 6 degree draft angle on the 

second side. 
d. Use Extrude.1 as the parting 

element.
e. Set the Neutral element on both 

sides equal to the parting 
element.
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Do it Yourself (6/6) 

8. Mirror the model.
• Complete the model by mirroring the 

part body about the YZ plane.

9. Clear the model, save and close it.
• Hide all wireframe and surface 

elements and save the model.
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Exercise Recap: Advanced Draft

Create an advanced draft
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Exercise: Multi-Body Work
Recap Exercise

15 min

In this exercise, you will open an existing part that contains a single feature. You will 
use the tools learned in this lesson to perform a Boolean operation, and create a 
multi-model link. High-level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Create Multi-Model links.

Perform Boolean Operations.

Modify Multi-Linked Models.
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Do it Yourself (1/2) 

1. Open the part file.
• Open the existing part file, 

Bracket_right.CATPart. There are two 
bodies in this file.

2. Perform a Union Trim operation on the 
PartBody using Body.2. 
• Use the union trim operation to trim 

Body.2 from the PartBody. Keep the top 
surface of Body.2 and the cylindrical 
surface from the PartBody.
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Do it Yourself (2/2) 

3. Create a new part file.
• Create a new PartBody called 

Bracket_Left. Create a multi-model link to 
the PartBody in Bracket_right.

4. Transform features.
• Use the symmetry tool to transform the 

notches in the Bracket_Left model. 
Perform the symmetry operation about the 
YZ plane.

5. Modify the hole in Bracket_Right.
• Modify the hole dimension in 

Bracket_Right to [5 mm] and update both 
the models.
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Exercise: Multi-Body Work Recap

Create multi-model links

Perform a Union Trim operation

Modify multi-model link models
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Case Study: Design Complex Parts
Recap Exercise

15 min

Base feature must include overall dimensions supplied.

Create each support as a single feature.

A cut is to be created to simulate the logo. The cut profile varies.

Links must be created to the Disk holder and the flex opening models 
to ensure conformance to standards.

Linked features must be kept in separate bodies.

An indented logo should not be displayed when it goes for 
manufacturing.

In this exercise you will create the case study model. Recall the design intent of 
this model:

Using the techniques you have learnt in this and previous lessons, create the model 
without detailed instructions.
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Do It Yourself: CD Jewel Case (1/7)

2. Create a pocket.
• Create a pocket using the dimensions 

shown on the front view of the drawing.

You must complete the following tasks:

1. Create a solid combine.
• Load JewelCase.CATPart
• Use the two sketches supplied to create a 

solid combine feature.
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Do It Yourself: CD Jewel Case (2/7)

0.79mm

3. Create a pocket.
• Create a second pocket using the 

dimensions shown. The cut is 
symmetrical about the ZX plane. This 
pocket needs to cut the material such that 
only a 0.79mm thickness is left.

You must complete the following tasks 
(continued):
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Do It Yourself: CD Jewel Case (3/7)

You must complete the following tasks 
(continued):

4. Create a rib feature.
• Create a rib feature using the dimensions 

shown on Detail view C and G of the 
drawing. The rib is symmetric about the 
ZX plane.

5. Create a second rib feature.
• Create a rib feature using the dimensions 

shown on Detail view B, E and H of the 
drawing. The rib is symmetric about the 
ZX plane. 

6. Create a third rib feature.
• Create a rib feature using the dimensions 

shown on detail view F and the front view 
of the drawing.
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Do It Yourself: CD Jewel Case (4/7)

You must complete the following tasks 
(continued):

7. Create a removed multi-sections solid.
• Create the logo using a removed multi-

sections solid. The lower profile is created 
on a reference plane that is offset 0.45mm 
below the top surface of the case. Use 
Detail view C and Section view D-D for 
the dimensions.

8. Create two pad features.
• Create two pad features using the 

dimensions shown on Detail views C and 
G. Consider creating only one Pad feature 
and mirroring it to create the other.
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Do It Yourself: CD Jewel Case (5/7)

You must complete the following tasks 
(continued):

9. Copy the DiskHolder and FlexOpening
bodies. 
• Copy the DiskHolder and the 

FlexOpening bodies from 
JewelCaseSubPart.CATPart using the 
Paste Special option As Result With 
Link.

10. Assembly the FlexOpening body to the 
main body.

11. Use the remove face tool to remove 
the logo from display.
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Do It Yourself: CD Jewel Case (6/7)
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Do It Yourself: CD Jewel Case (7/7)
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Case Study: Jewel Case Recap

Create a solid combine

Create rib features

Create a removed multi-
sections solid

Create multi-model links

Perform Boolean operations

Remove a face
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Surface Design
Learning Objectives
Upon completion of this lesson you will be able to: 

Access the Surface Design Workbench
Create the Reference Geometry
Create the Basic Surface Geometry
Create the Complex Surface Geometry
Perform Operations on Surfaces
Solidify the Model

3

4 Hours
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The case study for this lesson is the Computer Mouse.

Design Intent
Model contours are likely to change.

• This model is created from point data so that the 
geometry can quickly be changed simply by adjusting 
point locations.

Wire-frame, surface and solid geometry must be kept 
separate.

• By creating separate Geometrical Sets the model can be 
kept organized to help other users quickly identify the 
different elements making up the model.

Buttons must be built as a separate body but update 
when the changes are made to the main body.

• The button geometry can be created in a separate body 
will use surfaces from the main body as limiting elements.

Point data and Wireframes

Surface Geometry

Solid Geometry

Case Study

Stages in the Process
1. Access the Generative Surface Design workbench.
2. Create the wire-frame geometry. 
3. Create the surface geometry.
4. Perform operations.
5. Solidify the model.

Completed model
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Surface Design Workbench General Process

Introduction to Generative Shape Design

Wireframe and surface geometry is created with 
Generative Shape Design workbench to define 
complex shapes. 

Can be used by novice as well as advanced users.

Provides a set of comprehensive tools for making quick 
changes in the preliminary design and keeping the 
accuracy needed for the detailed design.

Lets you control the propagation of modifications when 
designing in context. You can reuse existing surfaces 
and other surface models. 

Datum curves or skins can be used to drive the design 
and can be quickly replaced if required.

1. Access the Generative Surface Design workbench.

2. Create the wireframe geometry.

3. Create the surface geometry.

4. Trim and join the body surfaces.

5. Access the Part Design workbench.

6. Create a part body.

7. Modify geometry as needed.

1

2

3

4

5

6
7
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Reference geometries are the basic elements which 
provide a stable geometric support. They can be used 
to limit and control the overall size of the part. Examples 
are: Points, Lines, Planes, and Axis systems.
CATIA has a fixed coordinate system called the 
Absolute Axis System. A point in the model will have 
coordinates specific to this axis system. 
You can also define user-defined axis systems known 
as Local Axis Systems. These can be anywhere in 3D 
space. There can be multiple axis systems in a single 
part.

Side limiting plane 

Local Axis System

Create the Reference Geometry

Create Curves

Curves are geometrical elements used as limiting 
elements (lines, planes), guides or references to 
create other elements. Some examples are:

A. Project-Combine curves (Projection 
curve, Reflect Line Curve, Intersection 
Curve, Parallel Curve)

B. Circular-Conic curves (Circle, Corner, 
Connect Curve, Conic)

C.Curves (Spline, Helix, Spiral)

Reflect Line
Curve

Circle

Spline

Intersection Curve

Corner

Helix

Parallel Curve

Connect Curve

Spiral
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Create the Basic Surface Geometry

Curve will always transmit
flaw to the surface

Curve with small flaw, 
used to make a surface

Great care should be taken while constructing the 
wire-frame geometry since surfaces inherit any  
flaws within the parent curves or wire-frame 
geometry, 

In a product development cycle a surface would be 
further used in downstream operations such as 
prototyping, machining, tooling, etc. and the final 
product would be adversely affected.

Create Curves (continued)

Complex 3D shapes often need to be defined 
using surface geometry which is created based on 
explicit wire-frame construction geometry. 

Some examples of basic surfaces are: Surface Geometry Solid Geometry

1. Extruded Surface

2. Revolve

3. Sphere

4. Cylinder Extrude Revolve Sphere Cylinder

21 3 4
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Create the Complex Surface Geometry

1. Sweep: A surface generated by sweeping a 
profile along a guide curve with respect to a 
spine. The profile can be a user-defined or      
pre-defined profile. The shape and quality of 
the sweep depends upon the spine.

2. Offset Surface: A surface which is offset from 
the reference surface.

3. Fill Surface: Created from a closed boundary. 
The boundary can consist of wire-frame 
elements or edges of existing surfaces.

4. Blend Surface: Created between two wire-
frame elements.

5. Multi-Sections Surface: Computed by passing 
through two or more sections along a spine. 
The spine defines the shape of the surface 
between two sections. Various options for 
defining multi-sections surface exists - Guides, 
Spine, Re-limitation, and Canonical elements.

Spine

Profile

Guide

Some examples of complex surfaces are: 1 Sweep

Offset Surface Fill Surface Blend Surface

2 3 4

Guide Curves

Section 1

Multi-Sections Surface
using Guide Curves

5

Section 2
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Completing the geometry in Part Design, with hybrid 
modeling capability of V5, enables the complex 
surface geometry to shape the solid part. Use the 
Part Design workbench to integrate surface 
geometry into a solid part. 
You can create the following surface based features 
in Part Design using the surface geometry.

1. Split
2. Thick surface
3. Close surface
4. Sew surface

Operations such as trim, join, extrapolate, and 
transform are performed to produce the required 
finished geometry. Transformations, such as scaling 
and affinity, help to resize the part. Transformation 
operations, such as translate and rotate, are required 
on the wireframe elements to change the positioning 
of the part in the co-ordinate axis system. Boundary 
operation extracts internal or external edge of the 
surface. Extract operation extracts sub-elements of a 
surface (edge or surface).

Solidify the Model

Surface Fillet operation 
to trim the surfaces

Healing operation 
to join the surfaces

Rotation about 
axis

Symmetry Extract

Boundary

Split

Thick
Surface

Close 
Surface

Sew Surface

Perform Operations on Surfaces
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Wireframe Geometry

1

2

3

4

Points: Creates a point or multiple points.

Line-Axis: Creates lines, axis or polyline.

Plane: Creates planes using different options.

Project-Combine: Projection curve, Combine 
curve and Reflect Line Curve

Intersection Curve: Creates a curve at the 
intersection of two elements.

Offset 2D3D: Creates a parallel curve and offset  
curve.

Circle-Conic: Creates circle, corner, connect 
curve, and conic curve.

Curves: Creates a spline, helix, spiral, and spine.

5

6

7

8

Main Tools (1/3)

7

8

1

2

4

3

5

6
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9 Extrude-Revolution: Creates extrude, 
revolution, sphere, and cylinder surface.

Offset: Creates an Offset Surface.

Sweep: Creates a swept surface.

Fill: Creates a fill surface.

Multi-Sections Surface: Creates a surface 
passing through multiple sections along the 
spine.

Blend Surface: Creates a blend surface 
between wireframe elements.

Surfaces

11

14

12

13

10

Main Tools (2/3)

Surface Features

Split: Splits a solid using a surface.

Thick Surface: Creates a solid from existing 
surface with thickness specified.

Close Surface: Creates a solid by closing the 
sides of the surface.

Sew Surface: Creates a Boolean operation and 
combines surface and solid.

20

21

22

23

9

13

14

10

11

12

20

21

22

23
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Join: Joins curves or surfaces.

Healing: Heals surfaces by filling in small gaps 
between the surfaces.

Trim-Split: Creates a Split surface and Trim 
surface.

Boundary: Creates a boundary from edge of 
the surface.

Extract: Extracts a face or a surface edge.

Multiple extract: Extracts a group of elements.

Fillets: Creates various types of surface fillets.

Transformations: Creates transformation 
features – translation, rotation, symmetry, 
scaling, affinity, and Axis to axis.

Operations

19

15

16

17

18

20

21

22

Main Tools (3/3)

15

17

18

19

21

16

20

22

18
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Exercise: Join, Trim and Close Surface
Recap Exercise

20 min

In this exercise, you will open an existing file that contains the wireframe and surface 
geometry necessary to complete the model. You will use the tools learnt in this 
lesson to perform operations and solidify the model. High-level instructions for this 
exercise are provided.

By the end of this exercise you will be able to:

Join Surfaces

Trim Surfaces

Mirror

Close a Surface
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Do it Yourself (1/5) 

2

2. Join the top and side surfaces. 
• Join Blend.1, Blend.2 and Sweep.1 

to create the top and side surface.
a. Select the Join icon.
b. Select Blend.1, Blend.2, and 

Sweep.1.
c. Click OK.

1. Open part file.
• Open the existing part file, 

Operations_Phone.CATPart. The 
wireframe and surface geometry has 
been created for you.
a. Create a new geometrical set 

called Operations.
b. Ensure that the Operation 

geometrical set is active.
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Do it Yourself (2/5) 

3

4
4. Trim the surfaces.

• Trim the bottom extrude and the trim 
feature.
a. Select the Trim icon.
b. Trim Extrude.3, and Trim.1.
c. Use the Other side of element

buttons to create the trim.
d. Click OK to complete the 

operation.

3. Trim the surfaces.
• Trim the top extrude and the join.

a. Select the Trim icon.
b. Trim Extrude.2, and Join.1
c. Use the Other side of element

buttons to create the trim as 
shown.

d. Click OK to complete the 
operation.
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Do it Yourself (3/5) 

5

6

6. Join the surface.
• Complete the surface model by 

joining the two halves.
a. Select the Join icon.
b. Select Trim.2 and Symmetry.1.
c. Click OK to complete the 

operation.

5. Mirror the model.
• Use the Symmetry tool to create the 

other side of the model.
a. Select the Symmetry icon.
b. Mirror Trim.2 about the ZX plane.
c. Click OK to complete the 

operation.
d. Hide Extrude.1 from the Surface 

geometrical set.
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Do it Yourself (4/5) 

7c

8
7d

7e

8. Add variable fillets.
• Complete the model by adding fillets. In 

this step, add variable fillets to the 
bottom side edges.
a. Select the Variable Edge Fillet icon.
b. Select both the edges of the bottom of 

the model.
c. Create the fillets with a [2mm] radius 

at the top and [4mm] radius at the 
bottom.

d. Click OK to complete the operation.

7. Solidify the model.
• Use the Close surface tool to solidify 

the model.
a. Access the Part Design 

workbench.
b. Activate the PartBody.
c. Select the Close Surface icon.
d. Select Join.2 as the object to 

close.
e. Click OK to complete the 

operation.
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Do it Yourself (5/5) 

10

9

11. Save and close the model.

9. Apply edge fillets.
• Create edge fillets for the top and 

middle side edges.
a. Select the Edge Fillet icon.
b. Select the top and middle edges 

on both sides (four edges).
c. Use a [2mm] radius.

10. Apply edge fillets.
• Complete the model by adding 2mm 

edge fillets to the top and bottom 
faces of the model.
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Exercise: Join, Trim and Close Surface Recap

Join surfaces

Trim surfaces

Mirror

Close a surface
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Case Study: Surface Design
Recap Exercise

40 min

In this exercise, you will create the case study model. Recall the design intent of 
this model:

Model contours are likely to change.

Wireframe, surface, and solid geometry must be kept 
separate.

Buttons must be built as a separate body, however it must 
be updated when changes are made to the main body.

Using the techniques you have learned in this and previous lessons, create the 
model with only high-level instruction.
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Do It Yourself: Model of Computer Mouse (1/15)

1
2

2. Create a semi-circle.
• Create a semi-circle. 
• Select XY plane as support.
• Create the center-point for the circle at:

X = -44.45, Y = 0, Z = 0.
• Have the circle run though a point located at:

X = 0, Y = 0, Z = 0.
• Create the circle starting at –90deg and 

ending at 90deg.

You must complete the following tasks:

1. Create a new part file.
• Create a new part file. Create a 

geometrical set inside the part called 
Wireframe and make the Wireframe 
geometrical set active.
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3. Create a spline.
• Create a spline through the following points:

Pt1:  X = 6.65, Y =0.00, Z = 12.70.
Pt2:  X = -38.10, Y = 0.00, Z = 25.40.
Pt3:  X = -69.85, Y = 0.00, Z = 31.75
Pt4:  X = -121.92, Y = 0.00, Z = 12.70
Pt 5: X = -139.70, Y = 0.00, Z = 0.00

Do It Yourself: Model of Computer Mouse (2/15)

3

4

4. Intersect elements.
• Using the Intersect tool to intersect 

the Spline with the YZ plane.

You must complete the following tasks 
(continued):
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Do It Yourself: Model of Computer Mouse (3/15)

5

6

6. Create trimmed circle.
• Create another circle using the 

Trimmed Circle option. Create the circle 
through the intersected and projected 
points.

You must complete the following tasks 
(continued):

5. Project elements.
• Project the semicircle end points 

onto the YZ plane.
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Do It Yourself: Model of Computer Mouse (4/15)

7

7. Create a spline.
• Create a spline through the following 

points:
Pt1:  X = 0.00, Y =38.10, Z = 0.00.
Pt2:  X = -38.10, Y = 38.10, Z = 0.00.
Pt3:  X = -68.58, Y = 44.45, Z = 0.00
Pt4:  X = -85.09, Y = 50.80, Z = 0.00
Pt 5: X = -114.30, Y = 38.10, Z = 0.00
Pt 6: X = -127.00, Y = 0.00, Z = 0.00

• Create the last point tangent to the ZX 
plane.

You must complete the following tasks 
(continued):
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Do It Yourself: Model of Computer Mouse (5/15)

9

10

10. Create an extrude.
• Create an extruded surface using 

Spline.2 as the profile. Extrude the 
surface [24.5mm] in the direction of 
the XY plane.

You must complete the following tasks 
(continued):

8. Create a new geometrical set.
• Create a new geometrical set called 

Body surfaces and ensure it is 
active.

9. Create a swept surface.
• Create a swept surface using 

circle.2 as the profile and spline.1 as 
the guide curve.
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Do It Yourself: Model of Computer Mouse (6/15)

11

12

1212. Create a blend.
• Create a blended surface to connect 

the two extruded surfaces. 
• Apply tensions on the blend as 

shown.

You must complete the following tasks 
(continued):

11. Create an extrude.
• Create an extruded surface using 

Circle.1 as the profile. Extrude the 
surface [24.4mm] in the direction of 
the XY plane.
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Do It Yourself: Model of Computer Mouse (7/15)

13

14

14. Perform a join operation.
• Join Blend.1 and Fillet.1 using the 

Join operation.

You must complete the following tasks 
(continued):

13. Create a shape fillet.
• Create a [25.4mm] shape fillet 

between the two extruded surfaces.
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Do It Yourself: Model of Computer Mouse (8/15)

15. Extrapolate an edge.
• Extrapolate the edge of the sweep 

[12.7mm].

You must complete the following tasks 
(continued):
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Do It Yourself: Model of Computer Mouse (9/15)

16

17

17. Solidify the model.
• Activate the PartBody and use the 

close surface tool to solidify Trim.1.

You must complete the following tasks 
(continued):

16. Trim surface.
• Trim Join.1 and Extrapol.1.
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Do It Yourself: Model of Computer Mouse (10/15)

18

19
19. Extrapolate the boundary.

• Extrapolate the edge of the offset 
surface [12mm].

You must complete the following tasks 
(continued):

18. Offset a surface.
• Reactivate the Body Surfaces 

geometrical set. 
• Offset Sweep.1 using the offset tool 

[5mm].
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Do It Yourself: Model of Computer Mouse (11/15)

20. Create a sketch.
• Create a plane [46mm] above the 

XY plane. Use this plane as the 
sketch support to create the sketch 
shown.

• Project the three curves along the 
front of the mouse and create a 
vertical line from the lower curve 
endpoint to a location on the upper 
curve. Use the trim tools to trim the 
upper projected line to the vertical 
line.

You must complete the following tasks 
(continued):
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Do It Yourself: Model of Computer Mouse (12/15)

21

22

22. Add thickness.
• Use the Thickness tool to add [–3mm] 

of thickness to the top of the pocket 
surface.

You must complete the following tasks 
(continued):

21. Create a pocket.
• Use the sketch as the profile for a 

pocket feature. Extrude the pocket 
up to the extrapolated offset surface.

• Create the pocket using Thin 
Pocket options with 2mm thickness.



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 99

Do It Yourself: Model of Computer Mouse (13/15)

25

23

25. Create a sketch.
• Copy Sketch.1 from the pocket into 

the Button body.
• Edit the sketch as shown.

You must complete the following tasks 
(continued):

23. Add thickness.
• Use the Thickness tool to add [–1mm] 

to the back surface.

24. Create a new body.
• Create a new body called Button.
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Do It Yourself: Model of Computer Mouse (14/15)

27

26

27. Shell the buttons
• Hide the PartBody and shell the 

buttons to a [2mm] inside thickness.
• Click OK to the warning message.
• Remove all the lower and inside 

faces from the pad feature.

You must complete the following tasks 
(continued):

26. Create a pad feature.
• Create a pad feature using the 

copied sketch. 
• Limit the pad feature between 

Sweep1and extrapolate.2.
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Do It Yourself: Model of Computer Mouse (15/15)

29. Save and close the model.

You must complete the following tasks 
(continued):

28. Clarify the display.
• Show the PartBody and the Buttons 

body. Hide the Wireframe and Body 
Surfaces geometrical sets.
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Case Study: Surface Design Recap

Create points

Create splines

Create projections

Create intersections

Create circles

Create swept surfaces

Create extrudes

Create blends

Create fillets

Perform a join operation

Extrapolate a boundary

Trim elements

Offset elements

Close a surface
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Analyze and Annotate Parts
Learning Objectives
Upon completion of this lesson you will be able to: 

Analyze the Part
Create 3D Constraints
Annotate the Part

4

3 Hours
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The case study for this lesson is a Bracket part. 

Design Intent

Stages in the Process
1. Analyze the Part
2. Create 3D Constraints
3. Annotate the Part

1. The model needs to be analyzed and scanned 
to verify that it follows company policy.

2. The model needs to be constrained. The 
creator of this model incorrectly constrained 
the holes. You need to make corrections.

3. Notes must be added. Your company policy 
requires that you make note of changes that 
you have made to the part.

Bracket

Case Study
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The following types of analysis can be done:

Create 3D Constraints
A 3D constraint is created on the 3D model. There 
are two types of 3D Constraints. Regular 
Constraints drive the design of the part, and can 
be driven if necessary. Reference Constraints are 
created and displayed in parentheses in place of 
Regular constraints if there a dimension exists 
which constrains the same aspect of the part.

AA. Thread and Taps Analysis: Used to visualize 
threads and tap information.

B. Draft Analysis: Used to analyze the ability of a 
part to be extracted for mold design.

C. Surfacic Curve Analysis: Used to analyze high 
quality surfaces.

B C

Thread and Tap 
Analysis

Draft Analysis Curvature Analysis

Select View > Render Style >Customized View and check 
the Material option to view the Draft and Curvature Analysis

3D Constraints

Analyze the Part

Annotations are added to display the additional 
information about the part. Some of the 
annotations that can be added to the part are 
Text, Text with Leader, and Flag Note. A Flag note 
links to the information stored in an external file.

Annotate the Part

Text with Leader Flag Note
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Analysis Toolbar

1

2

3

Draft Analysis: Analyzes the drafts on a part.

Curvature Analysis: Analyzes the curvature. 

Thread and Tap Analysis: Creates planes 
using different options.

Constraints

4 Constraint: Creates a 3D Constraint in a part.

Annotations Toolbar

5 Text with Leader: Creates annotation on a part 
with a leader.

Flag Note: Creates annotation on a part which 
links to an additional information stored in an 
external file.

6

Main Tools

2

1

3

4

5

6
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Case Study: Analyze and Annotate Parts
Recap Exercise

40 min

In this exercise, you will create the case study model. Recall the design intent of 
this model

Model needs to be Analyzed

Model needs to be constrained

Notes must be added

Using the techniques you have learned in this and previous lessons, create the 
model without detailed instructions.
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Do It Yourself: Annotate the Bracket (1/3)

3

4

1. Open a part file.
• Open Bracket-complete.CATPart.

2. Scan the part.
• Scan the part using the Scan tool. 

3. Perform a Draft Analysis.
• Convert the view mode to Material.
• Perform a Draft Analysis on the part.

a.Use the Quick Analysis mode
b.Select the Color Scale and On The 

Fly options.

4. Perform a Tap-Thread Analysis.
• Perform a Tap-Thread Analysis on the 

part. 
a.Clear the Show thread option.
b.Verify that all other options are 

selected except for Diameter.

You must complete the following tasks:
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Do It Yourself: Annotate the Bracket (2/3)

5

5
6

5. Constrain the part.
• One of the holes was created too close 

to a fillet. Constrain this hole to be 
[165mm] away from the other. 

6. Annotate the part.
• Create a text note indicating that the 

hole has been shifted. Enter the 
following text: [Hole was created too 
close to fillet. Distance has been 
changed from [118mm] to [165mm].

You must complete the following tasks:
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Do It Yourself: Annotate the Bracket (3/3)

66. Annotate the part (continued).
• Create a flag note, referencing a file that 

lists the assemblies in which this part 
will be used in.

a. Name: Assembly List
b. Link to File or URL: 

Assembly_List.xls
c. Modify the notes such that they are 

always parallel to the screen.
d. Hide the two view planes that were 

created while creating the two 
notes.

You must complete the following tasks:
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Case Study: Analyze and Annotate Parts Recap

Scan a Part

Perform a Draft Analysis

Perform a Tap-Thread Analysis

Constrain a Part

Annotate a Part
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Sharing Information
Learning Objectives
Upon completion of this lesson you will be able to: 

Create a Power Copy
Create Parameters and Formulas
Create a Design Table
Create a Catalog

4 Hours

5
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Case Study

The case study for this lesson is the angle bracket 
catalog.

Design Intent

Stages in the Process
1. Create a Power Copy
2. Create Parameters and Formulas
3. Create a Design Table
4. Create a Catalog

1. You must be able to modify the diameter of the 
boss hole.

2. The rib of the angle bracket must be related to 
the length.

3. A catalog of angle brackets must be available.
Power Copy Bracket

Catalog of Bracket with various 
design configurations
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A PowerCopy consists of a group of one or more 
features that can be re-used in other models. It 
differs from a typical copy because it contains 
references which enable you to position the 
copied features when inserting it in another model. 

PowerCopies are stored in the original model or in 
a Catalog.

While instantiating PowerCopies in the destination 
documents, you need to specify the necessary 
inputs and parameter values which will drive the 
feature parameters being instantiated.

An instantiation of a PowerCopy includes all the 
design specifications that originally made up the 
PowerCopy and the features can be modified. 

An instantiation of a User Feature hides the 
design specifications to preserve confidentiality of 
the features. 

PowerCopy Creation

PowerCopy Instantiation

PowerCopy Userfeature

Create a PowerCopy
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Introduction to Knowledgeware

CATIA V5 Knowledgeware is a set of tools to 
assist engineering decisions by detecting design 
errors and automating design for maximum 
productivity. The following terminology is used:

A. A parameter is a property with a given value 
defined as a feature in the specification tree.

B. A relation is a generic name for knowledge 
features, such as formulas and design tables.

C. A formula defines how a parameter is 
calculated with respect to other parameters.

D. A design table is an MS Excel or text table 
constraining a set of parameters. Each 
column defines parameter values. Each row 
defines a configuration.

E. A configuration is a set of parameter values.

A

B
C

D
E

The Wheel Rim has a number of user parameters. 
Number_of_Spokes is one such parameter. Above images 
show two configurations of the part created by two different 
values of the Number_of_Spokes.

Create Parameters
There are two kinds of parameters: intrinsic and user. 
Intrinsic parameters are created automatically. User 
parameters are created explicitly by the user.

Parameter values can be defined by relations or used 
as arguments in a relation.
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Formulas are relations used to define or constrain 
any parameter. They can be defined with 
parameters, operators, and functions. For example 
a formula is created the moment you attribute a 
user parameter to a feature. The left part of the 
relation is the parameter to constrain and the right 
part is a statement. 

When you are editing a formula, you can use pre-
defined functions, such as measures. The 
functions allow you to capture values from the 
geometry.

The design table provides you with a means to 
create and manage component families. These 
components can, for example, be mechanical 
parts differing in their parameter values. A design 
table can be created from the CATIA document 
parameters or from an external file. The values 
defining the design table are stored either in a 
Microsoft ® Excel file or in a tabulated text file.

Create a Design Table

The Bolt Design uses 
the Design Table. 
Different configurations 
of the bolt refer to 
different rows in the 
design table. Each row 
has a set of parameters 
that drive the design of 
the bolt.

Create Formulas
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A. Document: For example, an ISO Standards 
catalog will contain ISO standard parts. 

B. Chapter: Used to group entities with a common 
classification. i.e. Fasteners. Chapters may 
contain several component families such as 
Bolts, Pins and Nuts.

C. Family: A set of components with the same 
classification. For example – all types of Bolts.

D. Component: It is a reference to an entity stored 
in the catalog. For example – a Screw.

A catalog is a library of stored items used to avoid 
having to recreate frequently used geometry.
Catalogs can be created using the Catalog Editor 
Workbench. A catalog structure consists of the 
following elements:

B

C

A

D

Create a Catalog

Once the catalogs have been created, the catalog 
browser allows you to preview the objects in the 
catalog as well as to view and sort the object 
descriptions. 
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PowerCopy Tools

1

2

PowerCopy / PowerCopy Creation: Creates a 
new PowerCopy feature. The exact location of 
the PowerCopy tools varies depending on the 
active workbench. It can be accessed from 
Insert > Knowledge Templates menu or 
Insert > Advanced Replication Tools Menu.

Save In Catalog: Saves a PowerCopy feature 
in a Catalog. 

Instantiate from Document: Instantiates a 
PowerCopy from the existing document.

4 Catalog Browser: Instantiates a PowerCopy 
from a Catalog.

Knowledge Toolbar

5 Formula: Creates parameter / formula using 
the Formula editor.

Design Table: Creates a design table.6

3

1

2

3

4

5 6

Main Tools (1/2)
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Chapter Toolbar

7

9

Add Chapter: Adds a new Chapter in a 
Catalog/active Chapter.

Add link to Another Catalog: Adds link to 
another catalog.

Add Family: Adds family in a Chapter.

Add Part Family: Creates a Part family.

11 Add Keyword: Adds a keyword to a 
chapter/component family.

Add Component: Adds a component in a 
family.

Data Toolbar

10

8

Display With Browser: Displays a catalog 
browser.

Browser Toolbar

12

13

7

8

9

11

12

13

10

Main Tools (2/2)
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Exercise: PowerCopy and Catalog
Recap Exercise

10 min

In this exercise, you will create a PowerCopy, save it, and instantiate it. The features 
to be included in the PowerCopy have already been constructed for you. Limited 
instructions are provided for this exercise.

By the end of this exercise you will be able to:

Create a PowerCopy

Save PowerCopy in a catalog

Instantiate a PowerCopy from a catalog
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2. Create a PowerCopy of the pocket and its 
sketch.
a. Select Pocket.1 and Sketch.2 for the 

PowerCopy.
b. Rename the input to [Supporting Face].
c. Publish the following parameters: 

DepthDirection1, DepthDirection2, 
DistFromBottom, Height, and DistFromSide.

d. Take a screen grab of the pocket.
e. Click OK to complete the PowerCopy.

Do it Yourself (1/4) 

2a

2b

2c

2e

2d

1. Open Ex5BReference.CATPart.
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Do it Yourself (2/4) 

3

3b

4. Save the document.

5. Close the document.

6. Open Ex5B.CATPart.

3. Save the PowerCopy in a new catalog.
a. Click Insert > Knowledge Templates > Save In 

Catalog. The Catalog Save dialog box appears.
b. Click on the… button shown to select a directory 

and name for the catalog. The File Selection 
dialog box appears.

c. Specify a directory and a name for the catalog.
d. Click Open to accept the directory and name.
e. Click OK to save.
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Do it Yourself (3/4) 

7a

7c

7e
7d

7b

7. Instantiate the PowerCopy from the catalog.
a. Click the Open Catalog icon.
b. Click the Browse another catalog icon, locate 

the saved catalog, select it, and click Open.
c. Double-click on PowerCopy.
d. Double-click on 1 input.
e. Single-click on PowerCopy.1 preview.
f. Double-click on PowerCopy.1 to select this 

object for instantiation. The Insert Object dialog 
box appears.
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Do it Yourself (4/4) 

7g

7i

7. Instantiate the PowerCopy from the catalog 
(continued).
g. Select the face shown.
h. Select the Parameters button.
i. Change the value of the Height parameter to 

[15mm].
j. Click Close.
k. Click OK in the Insert Object dialog box. 7h

7j

7k
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Exercise: PowerCopy and Catalog Recap

Create a PowerCopy

Save a PowerCopy in a catalog

Instantiate a PowerCopy from a 
catalog 
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Case Study: Sharing Information
Recap Exercise

30 min

In this exercise, you will create and add a PowerCopy to the case study model. 
Then you will add the case study model to a part family catalog. Recall the 
design intent of this model:

You must be able to modify the diameter of the boss hole.

You must be able to access all features of the template geometry in 
the specification tree.

The rib of the angle bracket must be related to the length.

A catalog of angle brackets must be available.

Using the techniques you have learned in this and previous lessons, create the 
model with only high-level instruction.
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Do It Yourself: Angle Bracket Catalog (1/8)

1

2

3

1. Create a new part file.
• Create a new part file named Boss.

2. Create a Pad.
• Create a Pad with dimensions 20mm x 

20mm x 1mm. 
• Sketch on the XY plane.
• Constrain the lower, left corner of the 

square section to the sketch origin.

3. Create a Point.
• Create a point at the center of the top face 

of the pad.

You must complete the following tasks:
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Do It Yourself: Angle Bracket Catalog (2/8)

4

5

4. Create a Pad.
• Select the top of Pad.1 as the sketch 

support.
• Create a cylindrical pad and constrain the 

circular sketch to Point.1. The face of 
Pad.1 and Point.1 should be the only 
references selected.

• Enter [5mm] for the diameter of the circle.
• Enter [1mm] for the First Limit.
• Enter [2mm] for the Second Limit.

5. Create a Hole.
• Pre-select the top face of Pad.2 and 

Point.1.
• Create a 3mm diameter, simple hole that 

goes up to last.

You must complete the following tasks 
(continued):
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Do It Yourself: Angle Bracket Catalog (3/8)

6

8

6. Create a Fillet.
• Create a 0.5mm edge fillet on the top and 

bottom face of the part.

7. Save the model.

8. Create a PowerCopy
• A PowerCopy is used as all features of 

the boss must be accessible. 
• Add Pad.2, Hole.1, and EdgeFillet.1
• Rename the following Inputs:

– Pad.1\Face.1 = PlaceSurf
– Point.1 = PlacePnt

• Add the following Parameters:
– Radius of circle in the sketch for Pad.2
– Diameter of Hole.1

9. Save the model and close the window.

You must complete the following tasks 
(continued):
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Do It Yourself: Angle Bracket Catalog (4/8)

1112

13

10. Open AngleBracket.CATPart.

11. Create a Point.
• Create a Circle / Sphere center point. 

12. Create a Parallel Curve.
• Access the Generative Shape Design 

workbench.
• Offset the curve by [5mm]. 

13. Create two Points.
• Create an On curve point at the midpoint.
• Create an On curve point at the endpoint.

You must complete the following tasks 
(continued):
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Do It Yourself: Angle Bracket Catalog (5/8)

14

15

14. Insert a PowerCopy.
• Access the Part Design Workbench.
• Instantiate from Boss.CATPart.
• Select PlaceSurf and PlacePnt references 

to place PowerCopy.1.

15. Insert two PowerCopys.
• Use the Repeat option to insert two 

instances of PowerCopy.1 from 
Boss.CATPart.

• Modify the parameters:
– Pad radius = [3mm]
– Hole diameters = [4mm]

You must complete the following tasks 
(continued):
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Do It Yourself: Angle Bracket Catalog (6/8)

16

20

16. Mirror two PowerCopys.

17. Hide all wireframe elements.

18. Save the model.

19. Create Parameters:
• WallLength = 160mm from Sketch.1
• ShelfLength = 100mm from Sketch.1
• RibWall = RibLimit1 in Geometrical Set.1
• RibShelf = RibLimit2 in Geometrical Set.1

20. Create Formulas:
• RibWall = WallLength – (WallLength/10)
• RibShelf = ShelfLength – (ShelfLength/10)

You must complete the following tasks 
(continued):
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Do It Yourself: Angle Bracket Catalog (7/8)

21

22

21. Flex the model.
• Modify WallLength to [200mm].
• Modify ShelfLength to [140mm].
• Update the model.

22. Create a Design Table.
• Create a design table with current 

parameter values.
• Add WallLength and ShelfLength
• Edit the table to add PartNumber column 

and 12 instances.
• Create PartNumber parameter in CATIA 

to associate with the PartNumber column 
in the design table.

23. Save the model and close the window.

You must complete the following tasks 
(continued):
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Do It Yourself: Angle Bracket Catalog (8/8)

24

25

24. Create a Catalog.
• Rename Chapter.1 to [Bracket].
• Save as Bracket.catalog.

25. Add a Part Family.
• Rename the family to [AngleBracket].
• Add AngleBracket.CATPart.
• Resolve the Part Family.

26. Test the Design Table.
• Open HMR-L007 in a new window.

27. Save the catalog and close all 
windows.

You must complete the following tasks 
(continued):
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Case Study: Sharing Information Recap

Create a PowerCopy

Instantiate a PowerCopy

Modify PowerCopy parameters

Mirror a PowerCopy

Create Parameters

Create Formulas

Create a Design Table

Add a Part Family to a Catalog

Resolve Catalog instances
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Assembly Design
Learning Objectives
Upon completion of this lesson you will be able to: 

Manage the product structure
Create flexible sub-assemblies
Analyze the assembly
Create scenes
Create annotations
Generate reports

4 Hours

6
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The case study for this lesson is a lighting fixture.

Design Intent

Stages in the Process
1. Manage the product structure.
2. Create flexible sub-assemblies.
3. Analyze the assembly.
4. Create scenes.
5. Create annotations.
6. Generate reports.

1. You must be familiar with associated files
2. Modify the position of a sub-assembly without 

affecting other instances
3. Check for interference
4. Define an exploded state and save it for future 

use
5. Add textual information

Lighting Fixture assembly

Lighting Fixture assembly: Flexible 
Assembly concept is illustrated in the above 
example.

Case Study
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An assembly document contains links to all related 
CATIA documents and external files such as text 
and Excel files. The File > Desk command can be 
used to display and manage the product structure. 

1. Visualize the structure of linked components.
2. Load / Unload individual components.
3. See the links of CATProduct.
4. View the properties of component.
5. Find missing components and re-create links.

1. Quickly analyze the broken links.
2. Load / Unload individual components.
3. Activate / Deactivate components.
4. Isolate components.
5. Replace components.

The Edit > Links command can be used to manage 
the product components and the component links. 

Root Product
Child Documents Other linked 

documents

Manage the Product Structure

The Generate CATPart from the Product tool is 
used to create a non-associative CATPart file 
showing all active assembly nodes. The individual 
components are replaced by solid features. 

Product Structure links viewed using File > Desk command

Product Structure links viewed using Edit > Links command

CATProduct file

CATPart file generated 
from the CATProduct.
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A flexible sub-assembly is a sub-assembly whose 
child components can be moved without affecting 
either the child components of other instances of 
the same sub-assembly or referenced CATProduct 
of the sub-assembly. In the example shown, by 
making each leg sub-assembly flexible, each leg 
can be have a different configuration.

If a change is made to a flexible sub-assembly and 
the same change needs to be made on the rigid 
instances of the same referenced assembly, the 
Propagate position to reference option must be 
used.

Flexible sub-assembly is 
indicated by purple gear 
in the specification tree.

Create Flexible Sub- Assemblies

Create Scenes
Scenes enable you to capture assembly 
configurations without modifying the root product. 
You can do the following:

1. Change the Hide/Show state of components.
2. Change the color of components.
3. Change the position of components.
4. Change the activation states of representations.
5. Create drafting views based on scenes.

Three different states of gear box assembly are represented.

A drawing view is generated from an exploded view.
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The types of Analysis are as follows:

1. Component constraints using Analyze > 
Constraints.

2. Relationships between components using 
Analyze Dependencies.

3. Degrees of freedom using Analyze > 
Degree(s) of freedom.

4. Minimum distance between components, 
products and groups of documents using 
Distance and Band Analysis tool.

5. Assembly Sections using the Section plane.

6. Clash, interference, and clearance in the 
assembly using the Clash and Interference 
analysis tools.

Analyze the Assembly

2

1

3

4 5

6
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Annotations are added to assembly documents to 
provide additional information about a part or 
product. For example, a brief description of the part, 
the material used for the part, the finish or the  
hardness requirements. You can add three types of 
annotations:
A. Weld Feature: Adds weld symbols and 

annotations.
B. Text with leader: Adds a brief description of 

the part.
C. Flag note with leader: Adds links to external 

documents and/or URLs, such as a link to a 
presentation or a specification document.

Two types of reports can be generated:

Generate Reports

A. Bill Of Material: It lists all the assembly 
components as well as information such as 
quantity, type and description.

B. Listing Report: It lists all the assembly 
components. They are displayed in a 
hierarchical format.

Create Annotations

Listing Report

Bill of Material
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Manipulating Product Structure
1

2

File > Desk: Opens a window that displays a 
tree with a product and child documents.

Edit > Links: Displays the linked components 
of the CATProduct / CATPart / CATDrawing. 

Generate CATPart from Product: Creates a 
CATPart from the CATProduct.

4 Flexible/Rigid Sub-Assembly: Toggles the 
sub-assembly between flexible and rigid states.

3

Constraints Toolbar

Main Tools (1/2)

Scenes Toolbar

Enhanced Scenes: Creates a Scene.

Scenes Browser: Browses existing scenes.

Annotations Toolbar

Weld Feature: Creates a weld feature.

Text with Leader: Creates a text with leader.

Flag Note with Leader: Creates a flag note 
with leader.

5

6

7

8

9

1 2 3

4

5

6

7

8

9
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Analysis Tools

8

9

Analyze > Mechanical Structure: Analyzes 
the Mechanical Structure of the product.

Compute Clash: Computes clash/contact 
between two selected components.

Clash: Analyzes interference between the
products.

Sectioning: Creates a section using a section 
plane.

11

10
9

11

10

12
Distance and Band Analysis: Computes 
minimum distance between selected 
components and also performs a distance band 
analysis.

8

12

Main Tools (2/2)

5 Analyze > Constraints: Analyzes the 
constraints of an active product.

Analyze > Degrees of Freedom: Analyzes 
the degrees of freedom of the active product.

Analyze > Dependencies: Displays 
relationships between components and 
constraints.

6

7

5

6

7
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Exercise: Flexible Sub-Assembly
Recap Exercise

20 min

In this exercise, you will create flexible sub-assemblies within the top level assembly.

By the end of this exercise you will be able to:

Create flexible sub-assemblies

Manipulate flexible sub-assemblies
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Do it Yourself (1/11) 

1a

2a

2b

1. Open a product file.
• The product file has a base component that is 

fixed.  
a. Open Arms.CATProduct.

2. Assemble a sub-assembly.
• Apply constraints to assemble the sub-assembly.  

a. Assemble Links.CATProduct.
b. Apply a coincidence constraint between the 

reference planes.
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Do it Yourself (2/11) 

3

3. Add constraints. 
Add a contact constraint.The updated 
assembly appears as shown below
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Do it Yourself (3/11) 

4a

4. Assemble a second instance of a sub-
assembly.

• Both sub-assemblies are rigid by default.  
a. Assemble Arms.CATProduct as shown 

below.
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Do it Yourself (4/11) 

5a

5. Modify a sub-assembly.
• You will modify a rigid sub-assembly, both 

instances will be affected.  
a. Modify the 90 value of (Links.1) instance to 

45deg.
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Do it Yourself (5/11) 

6a

6. Update the assembly.
• Modifications are shared between rigid sub-

assemblies.  
a. Select the update icon. The assembly 

updates as shown below.
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Do it Yourself (6/11) 

7a

7b

7. Modify a rigid sub-assembly.
• Modifications to any instance of rigid 

sub-assemblies affect all instances of 
that sub-assembly.  
a. Modify the 120 dimension of 

(Links.2) sub-assembly to 90deg.
b. Update the assembly.
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Do it Yourself (7/11) 

8a

8b

8c

8. Make a sub-assembly flexible.
• You will make one of the two 

Links sub-assemblies flexible.  
a. Select Links (Links.2) sub-

assembly from the 
specification tree.

b. Select the Flexible/Rigid 
Sub-Assembly from the 
contextual menu.

c. The sub-assembly is now 
flexible, as indicated by the 
symbol in the specification 
tree.
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Do it Yourself (8/11) 

9a

9b

9. Modify a flexible sub-assembly.
• Changes made to a flexible sub-assembly will not 

propagate to a rigid instance.  
a. Modify the 90deg dimension of (Links.2) 

flexible instance to 130deg.
b. The updated assembly appears as shown 

below.
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Do it Yourself (9/11) 

10a

10b

10.Modify a flexible sub-assembly.
• Changes made to a flexible sub-assembly will not 

propagate to a rigid instance.  
a. Modify the 45deg dimension of (Links.2) 

flexible instance to 10deg.
b. The updated assembly appears as shown 

below.
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Do it Yourself (10/11) 

11a

11b

11c

11.Propagate position to reference.
• Although the rigid instance doesn’t update 

position with the flexible instance, you can 
propagate the position to the rigid instance.  
a. Select the flexible sub-assembly 

(Links.2).
b. Click Propagate position to reference.
c. The rigid (reference) sub-assembly 

updates to reflect the position of the 
flexible instance.
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Do it Yourself (11/11) 

12a

12b

12.Update the assembly.
• The propagation to position from a flexible sub-

assembly to a rigid reference sub-assembly is 
temporary.   
a. Select the Update icon.
b. The rigid sub-assembly returns to the 

reference position.
c. Save the assembly and close the file.
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Exercise: Flexible Sub-Assembly Recap

Create flexible sub-assemblies

Manipulate flexible sub-assemblies
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Exercise: Desk and Flexible Sub-Assembly
Recap Exercise

20 min

In this exercise, you will use the Desk command to rename a file. You will also create 
flexible sub-assemblies to achieve positional requirements.

By the end of this exercise you will be able to:

Create flexible sub-assemblies

Analyze the mechanical structure of an assembly
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Do it Yourself (1/6)

1a

2a

2b

1. Open a product file.
• This assembly is rigid. 

a. Open WheelArms.CATProduct.
2. Rename a file using the Desk command.

• You will use the Desk command to rename 
a part file. 
a. Select the rename icon.
b. Use the Desk command to rename 

WheelBase.CATPart part to 
WheelBasePlate.CATPart
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Do it Yourself (2/6)

3a

3. Analyze the mechanical structure.
• The mechanical structure that you will 

analyze is for a rigid assembly. 
a. Click Analyze > Mechanical 

Structure. The mechanical 
structure is reported in the 
Mechanical Structure Tree.
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Do it Yourself (3/6)

4a

4b

4. Make changes to a sub-assembly.
• By default, assemblies are rigid. 

a. Modify the 20deg dimension to 35deg.
b. The updated assembly appears as shown 

below.
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Do it Yourself (4/6)

5a

5. Make a sub-assembly flexible.
• Think about the hierarchy of the sub-assemblies. 

Make the appropriate sub-assembly
flexible so that the 35deg dimension 
can be changed to 10deg without 
affecting the other instance of the 
sub-assembly.



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 163

Do it Yourself (5/6)

6a

6a

6a

6. Make a sub-assembly flexible.
• Think about the hierarchy of the sub-assemblies. 

a. Make the appropriate sub-assemblies flexible 
so that the dimensions can be changed to 
create the positions shown below.
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Do it Yourself (6/6)

7a

7. Analyze the mechanical structure.
• The mechanical structure that you 

will analyze is for a flexible assembly. 
Notice how different it is to the 
mechanical analysis reported when 
the assembly was rigid. 

a. The mechanical structure is 
reported in the Mechanical 
Structure Tree.
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Exercise: Desk and Flexible Sub-Assembly Recap

Create flexible sub-assemblies

Analyze the mechanical 
structure of an assembly
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Case Study: Assembly Management
Recap Exercise

40 min

In this exercise, you will create the case study model. Recall the design intent of 
this model:

You must be familiar with associated files

Modify the position of a sub-assembly without affecting other 
instances

Check for interference

Define an exploded state and save it for future use

Add textual information

Using the techniques you have learned in this and previous lessons, create the 
model without detailed instructions.
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Do It Yourself: Lights (1/8)

2

1

You must complete the following tasks:

1. Open existing product file.
• Open Full_Assembly_light.CATProduct. 

2. View product links.
• Use the Desk command to view all 

associated files
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Do It Yourself: Lights (2/8)

You must complete the following tasks (continued):

3. Define a flexible assembly.
• Make the appropriate sub-

assemblies flexible. 
• You must achieve the 

configuration shown below.
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Do It Yourself: Lights (3/8)

4

5

You must complete the following tasks (continued):

4. Analyze for Bill of Material 
(BOM).

• Analyze BOM. 
5. Save the analysis.

• Save the analysis as a *.txt file.
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Do It Yourself: Lights (4/8)

You must complete the following tasks (continued):

6. View the saved text file.
• Open Lesson6.txt.
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Do It Yourself: Lights (5/8)

You must complete the following tasks (continued):

7. Analyze for interference.
• Analyze for Contact and Clash between 

all components.
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Do It Yourself: Lights (6/8)

You must complete the following tasks (continued):

8. Create a scene.
• Create a Full overload mode scene called 

Exploded State. 
• Define Part5 to be the Fixed product
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Do It Yourself: Lights (7/8)

You must complete the following tasks (continued):

9. Apply a scene.
• Apply the Exploded State scene to the 

assembly.
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Do It Yourself: Lights (8/8)

10

You must complete the following tasks (continued):

10. Add annotations.
• Add the text shown below.
• The font size of the text must be 7.00mm 

and it should always be parallel to the 
screen.
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Case Study: Assembly Design Recap

View associated files

Modify the position of a sub-
assembly without affecting 
other instances

Check for interference

Define an exploded state and 
save it for future use

Add textual information
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Contextual Design
Learning Objectives
Upon completion of this lesson you will be able to: 

Clarify the display
Create Contextual Parts
Create Assembly-Level Features
Manipulate the Contextual Components
Save the Contextual Models

8 Hours

7
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The case study for this lesson is the completion of an 
earphone model.

Design Intent

Using Projections from Housing part, you will 
design the sketch profile for the Ear Phone cover. 

1. Contextual links must be used to ensure that the 
ear phone cover references the Housing. 

2. Additional components may be added to this 
assembly depending on the model. To ensure that 
the oval cut intersects all components the cut must 
be created at the assembly level.

3. The assembly must be saved to another directory.
4. Using the Send To Directory option you can be 

sure that all files associated with the assembly are 
copied to the required directory.

Case Study

Stages in the Process
1. Clarify the display.
2. Create contextual parts.
3. Create assembly features.
4. Manipulate the contextual components.
5. Save the model.
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CATIA performance can be improved for large 
assemblies while panning, zooming, updating and 
saving. The following tools are used:

Powertrain Assembly

1. Visualization mode: In this mode only a light 
CGR representation of the model is loaded.

2. Hide: You can hide components to clarify the 
display and see only desired components.

3. Deactivate representations: Deactivating 
representations improves performance by 
hiding the components and excluding them 
from Mass Property analysis. 

4. Deactivate components: It will remove the 
component from show and no show space, bill 
of Material.

5. Selective load: Used to load the assembly up 
to a required depth and manage progressive 
loading of assemblies.

Visualization Mode

Hiding Components

1

2 3

Deactivating Representations

Deactivating 
Components

Selective Load

4 5

Clarify the Display
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Contextual parts are parts that have their geometry 
driven by another component. There are various 
ways to create contextual parts:

Housing

Pin

Base

1. Using External Parameters: Contextual links 
are created when the part uses a reference of 
parameters defined in another part.

2. Using External References: Contextual links 
are created when the part refers to geometrical 
elements from another part.

3. Using Assembly Features: Contextual links are 
created when there are Assembly features 
(Assembly Split, Remove, Hole) in a part. 

The hole 
from the pin support is 
used as an external 
reference to create the 
hole in the base part. 

Housing

The green gear and blue 
chain indicates the object 
is the original instance of 
a part that is contextual. 

1

2

Create Contextual Parts

The pin radius 
is used as an external 
parameter to create the 
hole in the housing. 

The benefits of using Design in Context:

1. Reuses existing geometry. 
2. Reuses parameters.
3. The contextual part is automatically updated 

when the geometry of the referenced part 
changes. The pin is used to 

create an assembly 
remove feature in 
the pin supports 
and housing. 

3
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Assembly features are features that are applied 
not only to a single part (from within the part 
design workbench) but to a set of several parts of 
an assembly.

The following Assembly features can be created: 

Hole: The hole feature 
affects both the parts.

1. Split
2. Hole
3. Pocket
4. Add
5. Remove

Split: The two parts 
are split by the surface.

Pocket: The elliptical 
pocket feature affects 
both the parts.

Add: The elliptical shaped 
body is added to the two parts.

Remove: The central hole 
is the result of removing 
a shaft feature from the 
two bodies.

2 3

4 5

1

Create Assembly-Level Features
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Various operations can be done as follows:
1. Isolate: The contextual links are broken. You 

can choose to isolate individual or all 
elements in a contextual part.

2. Delete: If the original instance of a driven part 
is deleted a new original instance should be 
established. When a component that drives a 
contextual part is deleted, the option to delete 
the contextual components that are driven by 
the component is available.

3. Save: After saving a driving CATPart with a 
new filename, the driven CATParts and the 
parent CATProduct must be saved because 
of their reference to the CATPart. After saving 
a contextual CATPart with a new filename, 
the parent CATProduct will need to be saved 
because of its reference to the driving 
CATPart. After saving a CATProduct with a 
new filename, the contextual CATParts that 
were defined in context of the CATProduct
will have to be saved because of the 
CATPart’s reference to the CATProduct

4. Copy: Using the Send to > Directory tool, you 
can create a copy of the CATProduct along 
with all related components.

Manipulate the Contextual Components

Isolated external references 
appear with the broken link,

Creating a copy of CATProduct using Send to > Directory.
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Tools > Options Settings

1

2

Work with the cache system: Activates the 
visualization mode.

Do not activate default shapes on Open:
Prevents loading the representation of the
Components in the CATProduct when it is opened.

Keep link with selected object: The object 
created with this option will keep the link with the 
original part/reference.

4 Design Mode: Loads the component in the
design mode.

Visualization Mode: Loads the component in the
visualization mode.

Activate Node: Activates the shape 
representation of the component.

Deactivate Node: Displays relationships between 
components and constraints.

5

6

Representation Tools

7

1

2

3

3

View Toolbar

8 Hide/Show: Hides/Shows the selected components.

Main Tools (1/3)

5

4

6

7

8
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Activate / Deactivate Tools

9 Activate / Deactivate Component:
Activates/Deactivates a selected component.

10

Split: Creates an assembly split feature.12

Selective Load: Manages the loading of sub-
products level by level.

Product Structure Tools

11 Formula: Creates formulae and parameters 
to incorporate design constraints.

Knowledge Toolbar

9

10

11

Assembly Features

Hole: Creates an assembly hole feature.13

Pocket: Creates an assembly pocket feature.14

Add: Creates an assembly add feature and 
adds the body to the selected parts.

15

Remove: Creates an assembly remove feature 
and subtracts the body from the selected parts.

16

12

13

14

15

16

Main Tools (2/3)
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Manipulating Contextual Parts

18 Delete: Deletes the selected component.

19 Save As: Saves the component with a new 
name.

Save Tools

17
17 Isolate: Isolates the part by removing 

contextual links.

18

20 Send to > Directory: Creates copy of the 
component in selected directory.

19

20

Main Tools (3/3)
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Case Study: Contextual Design
Recap Exercise

40 min

In this exercise you will create the case study model. Recall the design intent of 
this model:

Contextual links must be used to ensure that changes to the 
referenced parts are reflected in the contextual part

Contextual links can only reference the housing component

The oval cut may need to intersect other component that have not
yet been created

Assembly must be saved to another directory in its entirety

Using the techniques you have learnt in this and previous lessons, create the 
model with only high-level instruction.
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Do It Yourself: Earphone (1/11)

1

2

You must complete the following tasks:

1. Open existing product file.
• Open Earphone_start.CATProduct. 

2. Create a new part.
• Create a new part named 'Cover'.

3. Constrain the new part.
• Position the new part using reference 

elements of Housing component in order to 
center it on Bend_Point.

• Create a coincidence between 'Bend_Point' 
of Housing and XY plane of Cover.

• Create a coincidence between YZ plane of 
Housing and YZ plane of Cover.

• Create a coincidence between ZX plane of 
Housing and ZX plane of Cover.
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Do It Yourself: Earphone (2/11)

4

5

You must complete the following tasks (continued):

4. Unload components.
• Unload the Speaker, Rubber, and Flexible 

components.

5. Show a sketch.
• In Housing component show 'Sketch.3'.

6. Create a sketch.
• Activate the Cover component.
• In Cover component, create a new sketch 

lying on ZX plane.
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Do It Yourself: Earphone (3/11)

You must complete the following tasks (continued):

6. Create a sketch (continued).
• Project the three outlines of 

'Sketch.3' in this new sketch. Make 
sure the link is kept with Housing 
Component.

• Add geometry as shown on the 
scheme and exit the sketcher.
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Do It Yourself: Earphone (4/11)

7

8

You must complete the following tasks (continued):

7. Create a shaft.
• Create a complete Shaft around Z Axis with 

the sketch previously created.

8. Create a plane.
• Create a new plane defined with an offset of 

1mm from YZ plane. Reverse its direction if 
necessary. This plane will be used to split 
the shaft feature.



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 191

Do It Yourself: Earphone (5/11)

9

10

You must complete the following tasks (continued):

9. Create a split.
• Use this plane to split the current solid. Keep 

the biggest part of the solid.

10.Create a fillet.
• Define an edge fillet of Radius 2.5mm on the 

two corners of the Cover.



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 192

Do It Yourself: Earphone (6/11)

11

13

You must complete the following tasks (continued):

11. Create a groove.
• Create a groove reusing 'Sketch.2' (with 

link) from Housing component. 

12. Hide component.
• Hide the Housing component for clarity.

13. Create a fillets.
• Create two edge fillets of 5mm to 

smooth the edges left by the groove.
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Do It Yourself: Earphone (7/11)

14

You must complete the following tasks (continued):

14. Create a tritangent fillet.
• Create a tritangent fillet to remove 

the planar face.
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Do It Yourself: Earphone (8/11)

16

15

You must complete the following 
tasks (continued):

15. Create an assembly level pocket.
• Reuse Sketch.8 from the Housing 

component to create a Pocket at the 
assembly level that cuts through the 
Cover component. Use the Up to 
Last depth option.

16. Create a fillet.
• Activate the Cover component.
• Fillet the inner face of the pocket 

(Radius = 0.2mm).
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Do It Yourself: Earphone (9/11)

17

19

20

You must complete the following tasks 
(continued):

17. Create a sketch.
• Create a new sketch as shown. Use the  ZX 

plane as the sketch support. 

18. Create a pocket.
• Create a pocket using the Up to Last limit 

type for both the first and second limits.

19. Create a pattern.
• Create a rectangular pattern to duplicate the 

pocket.

20. Create fillets.
• Fillet both pockets (Radius 0.1mm)
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Do It Yourself: Earphone (10/11)

20

You must complete the following tasks 
(continued):

21. Add color to the part.
• You can apply the material of your 

choice (Painting for instance) on Cover 
component.

22. Display all components.
• Show the Housing component and Load 

the Speaker, Rubber, and Flexible 
components.
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Do It Yourself: Earphone (11/11)

25

23You must complete the following tasks 
(continued):

23. Verify links
• Ensure that only the Cover component 

has external links to the housing 
component.

24. Save the assembly.

25. Send the assembly to another 
directory.
• Create a new folder called 

Earphone_Complete and save the 
entire assembly to this directory.
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Case Study: Contextual Design Recap

Unload components

Create part in context

Hide components

Create an assembly level 
pocket

Load components

Show components

Save the entire assembly to 
another directory using the 
Send To command
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Complex Assembly Design
Learning Objectives
Upon completion of this lesson you will be able to: 

Stages in the Process
Create a Skeleton Model
Create the Published Elements
Use the Published Elements

4 Hours

8
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The case study for this lesson is a skateboard 
assembly.

Design Intent

Stages in the Process
1. Create a Skeleton model.
2. Create published elements. 
3. Use the published elements.

1. Component locations must be controlled from 
a centralized location using the skeleton 
method. 

2. Support geometry must update in all 
components using the skeleton approach.

3. References must be strictly controlled. Using 
published geometry, only published elements 
are allowed for selection when creating 
external references and assembly 
constraints.

Skateboard design using skeleton approach.

Skeleton part

Case Study
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The skeleton method is a top down design 
approach used to create and reuse information 
stored in a single part to define the underlying 
design framework of components and assemblies. 
It has the following advantages:

1. Specification-driven design: All important 
information related to the design and space 
requirements are defined within the skeleton.

2. Design change propagation: It helps manage 
high-level design changes and propagate them 
throughout the assembly.

3. Collaborative design: Key information stored in 
the skeleton model can be associatively copied 
into the appropriate components used in the 
product. The components can then be edited 
separately by different designers.

4. Avoids update loops: All are external 
references point to a single source: the 
skeleton. Since the skeleton model does not 
use any external references to define its 
geometry update loops are avoided.

Skateboard design using skeleton approach.

Skeleton

Create the Skeleton Model
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Publishing geometrical elements is the process by 
which geometrical features are made available to 
different users. It is most applicable to the 
geometry and parameters of a skeleton model. It 
has the following benefits:

A. Label geometry to give it a name that can be 
easily recognized (particularly in the case of 
publishing edges, faces, etc.). 

B. To make particular geometry easier to 
access from the specification tree.

C. Control external references. An option is 
available that lets you to select as external 
reference only ( For the published elements).

D. Easy replacement of one feature of the part 
with another. 

Use Publications for creating 
assembly constraints

Use Publications in contextual design

Create Published Geometry

Published geometry is particularly useful when 
replacing components with assembly constraints 
or components with external links that have been 
designed in context.

Use Published Geometry
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Publications

1 Tools > Publication: Creates publications of 
the selected element.

2 Assembly Constraints: You can choose to 
select options for using publications while 
creating assembly constraints.

External References: You can choose options 
while creating external references.

3

Tools > Options

2

3

1

Assembly Workbench

Part Workbench

Main Tools
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Exercise: Skeleton and Design in Context
Recap Exercise

90 min

In this exercise, you will use the tools learnt in the present and previous lessons to 
create an assembly using the skeleton method. You will use a skeleton model to 
control a rod and a piston assembly, by referring to its geometry to position 
components and design in context. High-level instructions for this exercise are 
provided.

By the end of this exercise you will be able to:

Use the skeleton method

Design a part in context using the skeleton model 
for external references

Constrain an assembly using a skeleton model
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Do it Yourself (1/14)

2

1

3

4

1. Create a new product file.
• Name the product 

[Piston_with_Skeleton].

2. Create Skeleton.CATPart.
• Create a new component inside 

the assembly called 
[Skeleton.CATPart].

3. Fix the skeleton model in the 
assembly.

4. Create user parameters
• Activate the skeleton component 

and create the five user 
parameters shown.

• Create the new parameters of 
type Length.
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5. Create additional skeleton geometry.
• The main dimensions of a model can be 

expressed not only with user parameters 
but also with geometry (planes, axis, 
points, etc.)
a. Create a point to locate the origin of 

the part.
b. Create five planes and rename them 

as shown:
i. Pin_Width = [35mm] offset from the 

YZ plane
ii. Piston_Inner_Face = [15mm] offset 

from the YZ plane
iii. Rod_Pin_Connector_Width = [1mm] 

offset from the Piston_Inner_face
iv. Rod_Crankshaft_Highest_Width = 

[12mm] from the YZ plane.
v. Rod_Crankshaft_Lowest_Width = 

[10mm] offset from the YZ plane.

Do it Yourself (2/14)

5bi 5biii

5biv 5bv

5a5bii
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Do it Yourself (3/14)

6

7

6. Create a line.
• Create a line named 

[Rod_Main_Axis] using the following 
references:

a. Type: Angle/Normal to curve
b. Curve: Z Axis
c. Support: YZ plane
d. Point: Origin
e. Angle: 10deg. 
f. Start: 0mm
g. End: Create a formula equal to the 

[Rod_Length] parameter.
• This line represents the direction of the 

rod.

7. Create a point.
• Create a point at the end of the 

Rod_Main_Axis.
• Name the point 

[Rod_Crankshaft_Middle_Point].
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Do it Yourself (4/14)

8
9

8. Create a plane.
• Create a plane normal to the 

Rod_Main_Axis and through the 
Rod_Crankshaft_Middle_Point.

• Rename the point to 
[Rod_Crankshaft_Middle_Plane]

9. Create a point.
• Create a point called 

[Fixation_Center_Point] using the 
following reference:

a. Type: On plane
b. Plane: 

Rod_Crankshaft_Middle_Plane
c. H = 0
d. V = From the contextual menu 

Edit Formula to be 
[Crankshaft_Diameter / 2 + 
Fixations_Diameter / 2 + 5mm]
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Do it Yourself (5/14)

10

10. Create a line.
• Create a line called [Fixation_Axis] 

using the following references. 
a. Type: Point-Direction
b. Point: Fixation_Center_Point
c. Direction: Rod_Main_Axis
d. Support: YZ plane
e. End: 25mm
f. Select the Mirrored Extent option
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Do it Yourself (6/14)

11

12

11. Insert an existing component.
• Insert the Rod.CATPart. 
• Use the following coincidence 

constraints to place the component: 
a. Rod_Crankshaft_Middle_Plane of 

skeleton with XY plane of Rod.
b. Rod_Crankshaft_Middle_Point of 

skeleton with ZX plane of Rod.
c. YZ plane of skeleton with YZ plane 

of Rod.

12. Insert an existing component.
• Insert the Connector.CATPart into 

the assembly. 
• Use the following coincidence 

constraints to place the component: 
a. Rod_Crankshaft_Middle_Plane of 

skeleton with XY plane of 
Connector.

b. Rod_Crankshaft_Middle_Point of 
skeleton with ZX plane of 
Connector.

c. YZ plane of skeleton with YZ plane 
of Connector.
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Do it Yourself (7/14)

13

13. Insert an existing component. 
• Insert the Piston.CATPart into the 

assembly. 
• Use the following coincidence 

constraints to place the component: 
a. XY plane of the skeleton with XY 

plane of the Piston.
b. YZ plane of the skeleton with YZ 

plane of the Piston.
c. ZX plane of the skeleton with ZX 

plane of the Piston.
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Do it Yourself (8/14)

14

14. Link the Rod component parameters.
• Activate the rod component and link the rod’s user parameters to the 

skeleton’s corresponding user parameters:
a. Pin_Diameter = [Pin_External_Diameter] of skeleton.
b. Crankshaft_Diameter = [Crankshaft_Diameter] of skeleton.
c. Fixations_Diameter = [Fixations_Diameter] of skeleton.
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Do it Yourself (9/14)

15

15. Replace geometrical elements.
• From the geometrical set, replace:

a. [Pin_Grip_Center] by [Origin] of skeleton.
b. [Connector_Thickness1] by 

[Rod_Crankshaft_Lowest_Width] of skeleton.
c. [Connector_Thickness2] by 

[Rod_Crankshaft_Highest_Width] of skeleton.
d. [Pin_Grip_Thickness] by 

[Rod_Pin_Connector_Width] of skeleton.
e. [Fixation_Center] by [Fixation_Center_Point] of 

skeleton.
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Do it Yourself (10/14)

16

17

16. Link the connector parameters.
• Activate the connector component and 

link the connector's user parameters to 
the skeleton’s corresponding user 
parameters:

a. Fixation_Diameter = 
[Fixation_Diameter] of skeleton.

b. Crankshaft_Diameter = 
[Crankshaft_Diameter] of skeleton.

17. Replace geometrical elements.
• From the geometrical set, replace: 

a. [Fixation_Center] by 
[Fixation_Center_Point] of skeleton.

b. [Connector_Thickness1] by 
[Rod_Crankshaft_Lowest_Width] of 
skeleton.

c. [Connector_Thickness2] by 
[Rod_Crankshaft_Highest_Width] 
of the skeleton.
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Do it Yourself (11/14)

19

18

18. Link the piston parameters.
• Activate the piston component and link 

the piston's user parameters to the 
skeleton’s corresponding user 
parameters:

a. Piston_Radius = Piston_Diameter
/2.

19. Replace geometrical elements.
• From the geometrical set, replace: 

a. [Left_Face_Plane] by [Pin_Width] 
of skeleton.

b. [Left_Inner_Plane] by 
[Piston_Inner_Face] of skeleton.
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Do it Yourself (12/14)

20. Create a new part. 
• Activate the top-level assembly.
• Create a new part named [Pin].

21. Position the pin.
• Constrain the pin component using the 

following coincident constraints.
a. XY plane of the skeleton with XY 

plane of the Pin.
b. YZ plane of the skeleton with YZ 

plane of the Pin.
c. ZX plane of the skeleton with ZX 

plane of the Pin.
• Update the assembly to place the 

component.
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Do it Yourself (13/14)

R 10 f(x)

4

22b

22. Create pin geometry.
• Activate the pin component and create the following 

contextual geometry. 
a. Activate the pin component.
b. Create the sketch shown on the YZ plane.
c. Create a formula to control the external radius. 

Make the external radius equal to half of the 
[Pin_External_Diameter] defined in the skeleton.

d. Create a pad feature. Create the pad up to the 
[Pin_Width] plane.

e. Create two chamfers [1mm/45deg] on the external 
face of the pin.

f. Mirror the pin geometry about the YX plane.
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Do it Yourself (14/14)

24

23

23. Edit specifications.
• Now that all the components of the product are linked to the 

specifications of the skeleton, we can change the general 
specifications of the product just by editing the skeleton. 

a. Activate the skeleton component.
b. Change the user parameter values:

a. Piston Diameter = 80mm
b. Pin_External_Diameter = 18mm
c. Rod_Length = 130mm
d. Crankshaft_Diameter = 45mm
e. Fixations_Diameter = 6mm

c. Change the value of the offsets for the following 
planes:

a. Pin_Width = 32mm
b. Rod_Crankshaft_Highest_Width = 10mm
c. Rod_Crankshaft_Lowest_Width = 8mm

24. Update the top-level assembly.
• Activate the top-level assembly and update it. Notice the 

changes made to the skeleton propagate through the entire 
assembly.
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Exercise: Skeleton and Design in Context Recap

Use the skeleton method

Design a part in context using 
the skeleton model for external 
references

Constrain an assembly using a 
skeleton model
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Exercise: Publication
Recap Exercise

20 min

In this exercise, you will open an existing assembly and replace one of its 
components. To ensure constraint references are not lost, you will publish elements 
in the replaced and replacing components. High-level instructions for this exercise 
are provided.

By the end of this exercise you will be able to:

Create published elements

Replace components
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Do it Yourself (1/4)

2

3

1. Open CRIC_SCREW1.CATPart.

2. Publish the axis as shown. 

3. Publish the face as shown.
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Do it Yourself (2/4)

5

6

4. Open CRIC_SCREW2.CATPart. 

5. Publish the axis as shown. 

6. Publish the face as shown.
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Do it Yourself (3/4)

7

9

7. Click Tools > Options > Mechanical 
Design > Assembly Design. From the 
Constraints tab set the Constraints 
creation option to Use published 
geometry of any level.

8. Open CricFirstAssembly.CATProduct.

9. Expand the CRIC_BRANCH1 
component. Notice that two of its 
elements are already published.
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13

Do it Yourself (4/4)

15

10. Assemble CRIC_SCREW1.CATPart 
using the published geometry.

11. Create a coincident constraint 
between the Axis and the 
BRANCH1_AXIS published 
elements.

12. Create a surface contact constraint 
between the FACE and the 
BRANCH1_FACE published 
elements.

13. Update the assembly.

14. Replace CRIC_SCREW1.CATPart 
with CRIC_SCREW2.CATPART.

15. Update the assembly. Notice the 
assembly constraints are 
automatically replaced because of 
the publications.

16. Save and close the assembly and 
all associated files.
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Exercise: Publication Recap

Create publications

Replace components
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Case Study: Complex Assembly Design
Recap Exercise

80 min

In this exercise, you will create the case study model. Recall the design intent of 
this model:

Component locations must be controlled from a centralized location.

Support geometry must be defined contextually.

References must be strictly controlled.

Using the techniques you have learnt in this and previous lessons, create the model 
with only high-level instruction.
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Do It Yourself: Skateboard (1/17)

4

2

1

3

5

You must complete the following tasks:

1. Ensure that the options are set 
correctly.

• Set the Constraint Creation option to 
Use Published Geometry of any level. 

• Set the External References options as 
shown.

2. Create a new product file.
• Name the product 

[Product_for_Support].
3. Insert Skeleton.CATPart.

• This model has been created for you. 
Review the created geometry. Notice 
that the publications have already been 
created for you.

4. Fix the skeleton model in the assembly.
5. Insert a new part called [Support].
6. Activate the support component.
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Do It Yourself: Skateboard (2/17)

8

9

7

You must complete the following tasks 
(continued):

7. Create a new point.
• Create a new point of coordinates 

[0,0,0].
• Rename the point to [Support_Origin].

8. Publish elements
• Publish the [Support_Origin] point.
• Publish the XY plane.
• Publish the ZX plane.

9. Position the support.
• Position the support in the product by 

creating the following coincidence 
constraints between the published 
elements in the support and those of 
the skeleton:

a. Support_Origin with 
Front_Support_Middle_Point.

b. XY plane with Support _Plane, 
choose the opposite orientation.

c. ZX plane with ZX plane.
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Do It Yourself: Skateboard (3/17)

11

12

11bYou must complete the following tasks 
(continued):

10. Insert a body.
• Insert a new body into the Support 

component, name the body [Base].

11. Create a sketch.
• Create the sketch shown on the XY 

plane. Ensure that all radii are equal.
• Constrain the outside radius shown 

to the “first_Hole_Center” point from 
the skeleton model. 

• You need to create only the top left 
quarter of the sketch, and mirror it 
twice to create the final sketched 
geometry.

12. Create a pad.
• Use the sketch to create a [3mm] pad.
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Do It Yourself: Skateboard (4/17)

2 deg Draft angle

Draft neutral 
face

17

15
14

13

You must complete the following tasks 
(continued):

13. Apply draft.
• Create a [2deg] draft on the sides of 

the pad. Use the top surface as the 
neutral plane.

14. Create a [1mm] edge fillet on the 
upper face of the pad.

15. Create a hole
• Create a M6 threaded-hole centered 

on the First_Hole_Center point of 
skeleton.

16. Pattern the hole.
• Pattern the hole using the 

Fixation_Pattern publication from the 
skeleton to locate the instantiations.

17. Create a chamfer.
• Create a [1mm/45deg] chamfer on 

the upper edge of the four holes.
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Do It Yourself: Skateboard (5/17)

19d

19b
19a

19c

20

You must complete the following tasks 
(continued):

18. Create a new body
• Create another body in the Support 

component called [Shock_support].

19. Create the sketch.
• Create the sketch shown on the ZX 

plane.
• You will need to project from the 

skeleton model:
a. The Front_Support_Axis
b. The Front_Shock_Absorber_axis
c. The Front_Shock1_Start_point
d. The Front_Axle_Connection_point

20. Create a pad.
• Create a pad of type Mirrored extent 

dimension. Use a length of [10mm].
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Do It Yourself: Skateboard (6/17)

21a

21b

22

You must complete the following tasks 
(continued):

21. Apply draft.
a. Add a [3deg] draft to the two sides 

of the draft. 
b. Use the top planar surface as the 

neutral plane.

22. Create a tritangent fillet.
• Create a tritangent fillet as shown.
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Do It Yourself: Skateboard (7/17)

24c

24b

24a

25

You must complete the following tasks 
(continued):

23. Create a new body.
• Create a new body in the Support 

component. 

24. Create the sketch.
• Create the sketch shown on the ZX 

plane.
• Create the sketch such that:

a. The angled line is perpendicular 
to the 
Front_Shock_Absorber_axis. 

b. The vertex of the horizontal line 
must be coincident with the 
Front_Shock1_Start_Point.

c. The vertical line must be 
coincident with the base edge.

25. Create a pad.
• Create a pad from the sketch or type 

Mirrored Extend Dimension and of 
length [7mm].
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Do It Yourself: Skateboard (8/17)

26

28c

28a

28b

27

You must complete the following tasks 
(continued):

26. Add draft.
• Add draft of [3deg] to both sides of 

the pad. Use the XY plane as the 
neutral plane. 

27. Remove the body.
• Remove the new body from the 

Shock_Support body.

28. Create fillets.
• Create three [1mm] edge fillets in the 

order shown.
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Do It Yourself: Skateboard (9/17)

31

6

29

You must complete the following tasks 
(continued):

29. Create a sketch.
• Create a sketch with absolute axis 

definition on the ZX plane position the 
sketch as shown using the following 
references:

a. Origin: Front_Shock1_Start_Point
b. V Direction: 

Front_Shock_Absorber_Axis. 

30. Create a groove feature.
• Create a groove feature using the 

sketch.

31. Add a chamfer.
• Add a [0.5mm/45deg] chamfer to the 

edges of the groove.
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Do It Yourself: Skateboard (10/17)

33

34

6

You must complete the following tasks 
(continued):

32. Create a new body.
• Create a new body in the Support 

component called Axle_Support. 

33. Create a shaft.
• Create the sketch shown. 
• Use the following references to 

position it:
a. Positioned on the ZX plane
b. Origin: 

Front_Axle_Connection_Point
c. V-direction: 

Front_Support_Axis

34. Split the body with the XY plane.
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Do It Yourself: Skateboard (11/17)

36

37

6

You must complete the following tasks 
(continued):

35. Create a hole.
• Create a [2mm] hole using Up to Last

option, centered on the 
Front_Axle_Connection_Point and in 
the direction of the 
Front_Support_Axis.

36. Create a groove.
• Create a groove feature using the 

sketch shown. Position the same as 
the last sketch:
a. Positioned: ZX plane
b. Origin: 

Front_Axle_Connection_Point
c. V-Direction: Front_Support_Axis

37. Create a fillet.
• Apply a [1mm] edge fillet to the top of 

the shaft.
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Do It Yourself: Skateboard (12/17)

38

39

40

You must complete the following tasks 
(continued):

38. Add the three previously designed 
bodies in the PartBody.

39. Create an edge fillet.
• Create a [1mm] edge fillet.

40. Create an edge fillet.
• Create a [0.7mm] edge fillet.
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Do It Yourself: Skateboard (13/17)

43

You must complete the following tasks 
(continued):

41. Open 
Skateboard_with_Skeleton.CATProduct.

42. Insert Support.CATPart.
• If you did not complete the Support.CATPart

from the previous steps, insert 
Support_Complete.CATPart instead.

43. Position the support component.
• Use published elements from the support 

and the skeleton to constrain the support.
a. Support_Origin with 

Front_Support_Middle_Point.
b. XY plane with Support_Plane, opposite 

direction.
c. ZX plane with ZX plane, same 

orientation.
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Do It Yourself: Skateboard (14/17)

45

You must complete the following tasks 
(continued):

44. Validate links.
• From the support component's 

contextual menu, click Components > 
Define Contextual links. Ensure all 
links are in connected status and 
validate by selecting OK.

45. Insert a new instance.
• Insert a new instance of the Support 

part and position it at the rear of the 
skateboard using the following 
coincidence constraints:

a. Support_Origin with 
Rear_Support_Middle_Point.

b. XY plane with Support_Plane, 
opposite direction.

c. ZX plane with ZX plane, opposite 
direction.
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Do It Yourself: Skateboard (15/17)

49

47a

You must complete the following tasks 
(continued):

46. Insert screw component.
• Insert ISO_SCREW_M6x10-Z.CATPart.

47. Position the screw.
• Position the screw by creating the 

following constraints between the 
published elements:

a. Coincidence constraint between the 
Hole of the Support.1 and the axis of 
the Screw.

b. Offset of [-3mm] between 
Support_Plane in the skeleton and 
Mating_Plane in the screw, opposite 
orientation.

48. Instantiate the screw.
• Instantiate the screw by reusing the user 

pattern created in Support component 
during the base conception.
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Do It Yourself: Skateboard (16/17)

50

51

49

You must complete the following tasks 
(continued):

49. Edit the skeleton.
• Change the coordinates of 

First_Hole_Center point to:
a. H = 7.5mm.
b. V = 20mm.

• Notice that all the points of the fixation 
pattern are recalculated accordingly.

50. Edit the skeleton.
• Change the value of 

Length_between_Wheel_Axis to 
[500mm].

• The wheel axes and fixation center is 
moved.

51. Update the assembly.
• Update the assembly and notice the

support geometry has been 
recalculated and the screws have 
been repositioned.
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Do It Yourself: Skateboard (17/17)

53

54

52

You must complete the following tasks 
(continued):

52. Edit the skeleton.
• Change the angle of 

Front_Shook_Absorber_Axis from 
[34deg] to [27deg].

53. Edit the skeleton.
• Change the angle of 

Front_Support_axis from [-3deg] to 
[-5deg].

54. Update the assembly.
• Update the assembly and notice 

that the support's geometry has 
been recalculated again. Notice that 
the screws have been repositioned 
to meet the new design 
requirements.
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Case Study: Complex Assembly Design Recap

Design in context using the skeleton method

Publish geometry

Position geometry using the skeleton method

Propagate design changes
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Master Project
Lifting Truck

4 Hours

The lifting truck has double poles with a carriage in which geometries and 
positions are guided by skeleton. The two forks are to be added for lifting / 
handling material. The forks are to be designed in the context of a skeleton so 
that they can be easily modified in future. A pneumatic jack will drive the 
distance between the two forks. You are provided with V4 data of the pneumatic 
jack.

Reuse V4 data and manage assembly constraints.
Modify rigid component into flexible to add mechanical constraints.
Create knowledge parameters and 3D specifications in skeleton structures, and use 
external references.
Define a skeleton, then design parts in context, and modify parameters to watch 
automatic geometry updates.
Analyze the assembly to check for clearance, and modify geometry by editing skeleton 
specifications.

By the end of this Project you will be able to:
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Master Project: Lifting Truck

During this project, you will follow sequential steps from inserting specifications 
to mechanical analysis through the design of components in assembly context.
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Master Project: Overview

Lifting_Truck 
main body

Jack made in CATIA V4 
with mobility and clearance 
guided by a skeleton
(Steps 1 & 5)

Double Pole 
designed for 
elevation

Plate with rails to 
support forks

Carriage_Skeleton with 
knowledge and geometric 
specifications for faster 
design modifications

Forks fully designed 
with external references 
from skeletons
(Steps 2, 3, 4)
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Master Project : Reuse the Existing V4 Jack
Lifting Truck

30 min

The objective of this step is to assemble the jack and to define parameters in the 
parent skeleton that will control the mobility of the jack. High-level instruction for 
this exercise is provided.

• Load a V4 model of the jack and save it as CATProduct.
• Insert this jack into the correct sub-assembly of Lifting 

Truck.
• Constrain components of the jack.
• Assemble the jack onto the support plate.
• Instantiate bolts.
• Add geometric specifications driven parameters in the 

parent skeleton.
• Make the jack flexible.

By the end of this step, you will be able to:
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Master Project: Reuse the Existing V4 Jack (1/4) 

mobility

mobility

Right Rod group

Left Rod group

Main Body group

Here is a list of required tasks to guide you:

1. Open the V4 assembly.
• Open Fork_Jack_V4_Step1.session.
• Save it locally.

2. Add assembly constraints.
• Add constraints between components but 

keep the degrees of freedom appropriate for 
the actual mobility of a jack.

• Avoid the Fix Together constraint.
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Master Project: Reuse the Existing V4 Jack (2/4) 

2 bolts

V4-Jack

Main plate

Here is a list of required tasks to guide you 
(continued):

3. Open the top-level assembly.
• Open Lifting_Truck_Step1.CATProduct.
• Save it locally. 

4. Insert the jack component.
• Insert Fork_Jack_V4 into 

Assembled_Carriage sub-assembly.
• Add constraints using planes of 

Carriage_Skeleton, and existing holes of 
the main plate.

• Instantiate two bolts and constrain them. 
Use catalog bolt M8x30 or use the 
provided parts.



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 251

Master Project: Reuse the Existing V4 Jack (3/4) 

C

C

B

E

Here is a list of required tasks to guide you 
(continued):

5. Add specifications to the parent skeleton 
that will be used to control the mobility of 
the jack.

A. Edit Carriage_Skeleton, which is in the 
Assembled_Carriage.CATProduct sub-
assembly.

B. Add a parameter called 
between_forks_gap.

C. Add two planes offset from the ZX plane 
to define the forks’ positions along Y-
axis.

D. Publish these new elements.
E. Drive the plane offsets by adding 

formulas between the parameter and 
planes offset values.
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Master Project: Reuse the Existing V4 Jack (4/4) 

Here is a list of required tasks to guide you (continued):
6. Constrain the rods of the jack to the parent 

skeleton using a flexible sub-assembly.
• Edit Assembled_Carriage.CATProduct.
• Make V4_Jack flexible.
• Add constraints between the rods’ extremity 

axes and the new planes of 
Carriage_Skeleton.

7. Check the assembly by modifying the 
parameter.

• Edit Carriage_Skeleton.CATPart.
• Change the value of between_fork_gap from 

600mm to 650mm.
• Edit Assembled_Carriage.CATProduct and 

update. Both the rods should follow the 
modification.

8. Add range values to the parameter.
• Edit Carriage_Skeleton.CATPart.
• Add range value to the between_fork_gap

parameter (min = 525mm  ; max = 750mm).

9. Save all.
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Master Project: Reuse the Existing V4 Jack Recap

Load a V4 model of the jack and save it as 
CATProduct
Insert this jack into the correct sub-assembly 
of Lifting_Truck
Constrain components of the jack
Assemble the jack onto the support plate
Instantiate bolts
Add geometric specifications driven 
parameters in the parent skeleton
Make the jack flexible
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Master Project: Preparing for Design in Context
Lifting Truck

60 min

The objective of this step is to create a new skeleton to prepare the design of the 
forks in the following steps. High-level instructions for this exercise are provided.

• Insert a skeleton in a new product in the carriage assembly.
• Constrain the new skeleton to the parent skeleton.
• Import the carriage assembly specifications from its 

skeleton into the new skeleton.
• Create knowledge parameters in the new skeleton.
• Add 3D geometry in the new skeleton using knowledge 

formulas.

By the end of this step, you will be able to:
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Master Project: Preparing for Design in Context (1/8)

Continue with the models used in step 1. If you 
did not complete step 1, use 
Lifting_Truck_Step2.CATProduct.

Here is a list of required tasks to guide you:

1. Insert a new sub-component in 
preparation for design-in-context of the 
forks.

• Load Assembled_Carriage.CATProduct.
• Insert a new product with a fixed new 

part (the skeleton) as shown in the 
specification tree.

• Publish the XY, YZ, ZX planes of the 
skeleton.

• Save all locally.
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Master Project: Preparing for Design in Context (2/8)

Before constraints:

After constraints:

Here is a list of required tasks to guide you 
(continued):

2. You need to place the forks skeleton on 
the carriage skeleton before using 
external references for the design in 
context. Constrain the fork skeleton’s 
origin with respect to the Top Rail contact 
planes.

• Edit Assembled_Carriage.CATProduct.
• Add constraints between the forks 

skeleton and Carriage_Skeleton as 
shown. The forks skeleton will be 
superimposed onto the parent skeleton.

• Save all.
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Master Project: Preparing for Design in Context (3/8)

a

b
c

Here is a list of required tasks to guide you 
(continued):

3. Import the external specifications into the 
forks skeleton.

• Copy the following specifications of 
Carriage_Skeleton:

a. Plane_Right_Fork_Position
b. Plane_Left_Fork_Position
c. Plane_Fork_Jack_Height_Position
d. Fork_Rail_height_gap parameter

• Paste them as result with link into the 
forks skeleton.

• Publish these external features in the 
forks skeleton.

• Save all.



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 258

Master Project: Preparing for Design in Context (4/8)

To help, here is a list of required tasks (continued):

4. Identify the parameters that must be inserted in the forks skeleton.
• Study the dimensions of the assembly. All dimensions are in mm.
• Identify the required parameters that you will insert into the forks skeleton. You will create the 

required 3D geometry driven by those parameters.
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Master Project: Preparing for Design in Context (5/8)

a
b

c

d

To help, here is a list of required tasks 
(continued):

5. Create the parameters in the forks 
skeleton.

• Create the following tree structure in the 
forks skeleton.

a. External parameters contain the 
imported parameter from 
Carriage_Skeleton.

b. Parameters contain all the 
parameters you have to create. 
Publish them.

c. External references contain the 
geometric specifications imported 
from Carriage_Skeleton.

d. You can create new geometrical 
sets in order to sort the geometric 
specifications you are about to 
create.

e. Do not forget to publish all the 
specifications you will create.
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Master Project: Preparing for Design in Context (6/8)

Parts not 
created yet.

A

Fork_Rail_Height + 2mm 
gap for spacing between
bottom rails

B

B

B

To help, here is a list of required tasks 
(continued):

6. Create the forks skeleton’s 3D geometry.
A. In the geom_depth_specifications

geometric set, create four planes using 
the previously given 2D drawing and 
depth parameter. 

B. In the geom_rails_height_specifications
geometric set, create seven planes using 
the previously given 2D drawing and the 
Rail_Height external parameter.
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7. Create the forks skeleton’s 3D geometry 
(continued).
C. In the geom_width_specifications

geometric set, create four planes 
using the previously given 2D 
drawing, width parameter, and 
imported planes. 

D. In the geom_length_specifications
geometric set, create two planes 
using the previously given 2D drawing 
and parameters.

Master Project: Preparing for Design in Context (7/8)

Fork Width

Fork Length

C C CC

D

To help, here is a list of required tasks 
(continued):



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 262

Master Project: Preparing for Design in Context (8/8)

Length
Rail 
Height

Width

To help, here is a list of required tasks (continued):

8. Create the forks skeleton’s 3D geometry (continued).
• Upon completion of this step you should get this result.
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Master Project: Preparing for Design in Context Recap

Insert a skeleton in a new product in the 
carriage assembly
Constrain the new skeleton to the parent 
skeleton
Import the carriage assembly specifications 
from its skeleton into the new skeleton
Create knowledge parameters in the new 
skeleton
Add 3D geometry in the new skeleton using 
knowledge formulas



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 264

Master Project: Design of Right Fork Assembly
Lifting Truck

90 min

The objective of this step is to design the right fork assembly by using 
specifications of the forks skeleton created in previous step. High-level 
instruction for this exercise is provided.

• Design new parts in the context of the skeleton.
• Insert additional components.

By the end of this step, you will be able to:
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Master Project: Design of Right Fork Assembly (1/6)

A

B

C

Continue with the models used in step 2. If you 
did not complete step 2, use 
Lifting_Truck_Step3.CATProduct.

Here is a list of required tasks to guide you:

1. Create a new part in 
Assembled_Forks.CATProduct.

A. Insert a new CATPart called Right_Fork.
B. Publish its planes.
C. Constrain it onto the forks skeleton to 

place it on the right side of fork 
assembly.

2. Use the Part Design workbench to design 
its shape with respect to the skeleton.

A. Use a rib with two sketches to create the 
profile.

B. Add a tritangent fillet and edge fillets.
C. Apply a shell with a parameterized 

thickness.
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Master Project: Design of Right Fork Assembly (2/6)

Right_Fork
Origin

Oblong hole 
centered onto 
Jack_Height
plane

Here is a list of required tasks to guide you 
(continued):

D. Add pockets for placing Fork_Plates and 
Fork_Mobile_Axis.

E. Remove material to obtain the bottom 
slope.

F. Use the Part Design workbench to 
design its shape with respect to the 
skeleton.

E

D
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Master Project: Design of Right Fork Assembly (3/6)

A
B

A B

D
C

Here is a list of required tasks to guide you 
(continued):

3. Design the molded hook up part. Assume 
the design will not be associative with the 
product specification, and therefore does 
not require any external references.
• Insert a new CATPart called 

Hook_Up.CATPart in 
Assembled_Forks.CATProduct.

• Publish its planes.
• Constrain it onto the skeleton to place 

it on the right side.

4. Use the Part Design workbench to design 
its shape.
A. Create pads.
B. Create drafts and fillets.
C. Create counterbored holes.
D. Create a pocket.
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Master Project: Design of Right Fork Assembly (4/6)

Here is a list of required tasks to guide you 
(continued):

4. Use the Part Design workbench to design 
its shape (continued).
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Master Project: Design of Right Fork Assembly (5/6)

D

Here is a list of required tasks to guide you 
(continued):

5. Design the the fork plate in the context of 
the skeleton created in Step 2.

• Insert a new CATPart called 
Fork_Plate.CATPart in 
Assembled_Forks.CATProduct.

• Publish its planes.
• Constrain it onto the skeleton to place it 

on the right side.

6. Use the Part Design workbench to design 
its shape with respect to the skeleton.

• Create a pad.
• Create holes. The position of the holes 

should not follow any parameter as 
those in Hook_up holes do not.
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Master Project: Design of Right Fork Assembly (6/6)

Here is a list of required tasks to guide you 
(continued):

7. Assemble the remaining components.
A. Insert a screw (M8x25 CHC from 

catalog, or use the provided one) and 
add constrain it to the existing parts.

B. Repeat this for the four screws.
C. Load Fork_Mobile_Axis.
D. Save it locally.
E. Drag and drop it into Assembled_Fork.
F. Add constraints with respect to the 

skeleton.
G. Add two screws.
H. Copy/Paste Fork_Plate, Hook_Up, and 

the four screws.
I. Move these components and add 

constraints to place them onto the 
bottom notch of Right_Fork.

8. Save all.
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Master Project: Design of Right Fork Assembly Recap

Design new parts in the context of the 
skeleton
Insert additional components
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Master Project: Design of Left Fork Assembly 
Lifting Truck

45 min

The objective of this step is to design the left fork using the PowerCopy tool 
from the right fork. You will then instantiate other components and constrain 
them in the assembly. High-level instruction for this exercise is provided.

• Insert a new empty part and constrain it onto the skeleton.
• Create the right fork’s geometry PowerCopy.
• Use right fork’s design PowerCopy in this new part by 

changing some geometrical references.
• Instantiate all components needed for the assembly.
• Modify Skeleton’s parameters and notice automatic 

geometry modifications.

By the end of this step, you will be able to:



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 273

Master Project: Design of Left Fork Assembly (1/3)

Continue with the models used in step 3. If you did not 
complete step 3, use Lifting_Truck_Step4.CATProduct.

Here is a list of required tasks to guide you:

1. Create a new part in Assembled_Forks.
• Insert a new CATPart called Left_Fork.
• Publish its planes and constrain it to the forks skeleton on 

the left side.

2. Create a PowerCopy of Right_Fork.
• Edit Right_Fork and PowerCopy all elements of PartBody 

(features and sketches) and Relations (formulas).
• Save the PowerCopy in a new local catalog.

3. Use the PowerCopy to design the Left_Fork.
• Edit Left_Fork and use the catalog browser to instantiate 

the PowerCopy.
• Replace the external references for the width and length 

definitions. Select the same specifications for all other 
external references from the skeleton.

• Validate. Left_Fork is now created.

4. Save all.
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Master Project: Design of Left Fork Assembly (2/3)

Here is a list of required tasks to guide you 
(continued):

5. Instantiate the elements required for mechanical 
assembly. Left_Fork must be exactly like 
Right_Fork.

• Instantiate the following in 
Assembled_Forks.CATProduct:

• 2 Hook_Up
• 2 Fork_Plate
• 1 Fork_Mobile_Axis
• 6 Screws

• Add constraints.
• Save all.
• Instantiate the following in 

Assembled_Carriage.CATProduct:
• 2 washers (M10), are already existing in the 

local files
• 2 nuts (M10)

• Add constraints.
• Save all.
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Master Project: Design of Left Fork Assembly (3/3)

Here is a list of required tasks to guide you 
(continued):

6. Modify the parameters in the skeleton to 
check if the geometry is properly driven by 
the wireframe reference elements.

• Note that Fork_Depth must not exceed 
Fork_Bottom_Angle_Radius.

• Note that Fork_Bottom_Angle_Radius
must not exceed 50mm as bottom rail 
position is not dependant of this 
parameter.

• Do not save those last modifications.
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Master Project: Design of Left Fork Assembly Recap

Insert a new empty part and constrain it onto 
the skeleton
Create the right fork’s geometry PowerCopy
Use right fork’s design PowerCopy in this 
new part by changing some geometrical 
references
Instantiate all components needed for the 
assembly
Modify Skeleton’s parameters and notice 
automatic geometry modifications
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Master Project: Jack Clearance Check 
Lifting Truck

15 min

The objective of this step is to make sure that the 10mm clearance between “V4 
Jack” and “top rail” is respected. High-level instruction for this exercise is 
provided.

• Analyze the clearance between the jack and the fork guide 
(i.e., the supporting top rail).

• Perform a modification to the correct skeleton specification 
to achieve the clearance.

• Restart the analysis to check the impact of the design 
change.

By the end of this step, you will be able to:
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Master Project: Jack Clearance Check (1/3)

Continue with the models used in Step 4. If you 
did not complete Step 4, use 
Lifting_Truck_Step5.CATProduct.

Here is a list of required tasks to guide you:

1. Create a clearance analysis in 
Assembled_Carriage.CATProduct.

• Create a clearance analysis as shown 
using Fork_Guide (Fork_Guide.1) and 
Fork_Jack_V4.CATProduct 
(Fork_Jack_V4_STEP1________SESSI
ON) as the selections.

• Apply it. You have three results for which 
distance values are less than the 
required clearance.

• Select one of them. A new window shows 
a 3D preview of concerned sub-elements 
of the selections.

• Select the interference with the lowest 
spacing value.

• Click OK. The spacing value appears in 
the 3D view. The analysis appears in the 
tree under the Applications branch.



CATIA V5 Mechanical Design Expert
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 279

Master Project: Jack Clearance Check (2/3)

Here is a list of required tasks to guide you 
(continued):

2. Use a sectioning view to gain a better 
view of the clearance, and of the 
geometric modification you will make.

• Create a sectioning view in In 
Assembled_Carriage.CATProduct.

• Cut the 3D view along section view.
• Place section view on the gap 

dimension.
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Master Project: Jack Clearance Check (3/3)

Here is a list of required tasks to guide you 
(continued):

3. Modify one specification in the skeleton to 
correct the clearance around V4_Jack.

• In Assembled_Carriage.CATProduct, edit 
Carriage_Skeleton and increase the offset 
value of Plane_fork_Jack_height_position by 
10mm.

• Update the assembly.
• Notice that the following elements have been 

automatically modified.
• Fork support plate
• Right fork & left fork
• Jack height position
• Bolts constrained with those elements
• The section view is also updated

• Edit the clearance analysis to re-apply with 
the same parameters. No interference must 
be detected now. You can use a Distance & 
Band Analysis to measure the new distance.

4. Save All
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Master Project: Jack Clearance Check Recap

Analyze the clearance between the jack and 
the fork guide (i.e., the supporting top rail)
Perform a modification to the correct 
skeleton specification to achieve the 
clearance
Restart the analysis to check the impact of 
the design change
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Glossary

Activate: It is an operation of making a 
component active by double-clicking on it.

Add: It is a Boolean operation in which features 
in another body are added to the current body.

Affected Part: This is a part which is affected by 
the Boolean operation and will undergo change in 
its geometry as a result of this operation.

Affinity: It is an operation in which an element is 
transformed by applying X, Y, Z affinity ratios with 
respect to a reference axis system.

Assemble: It is a Boolean operation in which a 
union will be performed between the two bodies.

Assembly feature: It is a feature created by 
assembly Boolean operations (split, hole, pocket).

Associativity: It is a term which represents 
interdependent relationships between entities.

Bill of material: It is a list of data about the 
components contained in the active component.

Boolean operation: It is an operation in which two 
or more bodies are added, removed, split, trimmed.

Cache: It is an option by which you can enable the 
visualization mode wherein light CGR models will be 
loaded while opening the assembly in CATIA.

Center Curve: It is a tangency continuous curve 
along which a rib or a slot feature is computed.

CGR: It is a CATIA Graphical Representation (CGR) 
file type.

Child feature: It is a feature originating from an 
original feature (parent feature).

Closing Points: It is the end point of the profile
Component.

Concurrent engineering: It is a practice in which 
the design of various parts in an assembly is done 
concurrently by various designers and final 
assembly is created after integrating these parts.
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Glossary

Construction geometry: It is a set of geometric 
elements used in the sketch profile as construction 
elements and are useful in constraining / creating 
main sketch profile.

Coupling: It is an option in Multi-section Solid 
definition. The coupling decides the shape of the 
multi-section solid computed between the two 
sections.

Define in work object: It is making the current 
feature active.

Degree of freedom: It is a numerical value 
indicating the number of ways a part can move in 
the 3D space.

Design mode: It is a mode in which the geometrical 
representations of the assembly and its parts are 
loaded and accessible for review and modification.

Design Table: It is a table containing various 
configurations of design created by a specifying a 
set of parameters for each design.

DMU: It is an abbreviation for Digital Mock-Up.

Draft: It is a feature provided with a face with an 
angle and a pulling direction.

Driving part: It is a part whose value is determined 
by an external parameter and is driven by this 
external parameter.

Driving property: It is a property whose value is 
determined by an external parameter and is driven 
by this external parameter.

Exploded state: It is a state where the assembly 
parts are in an exploded condition.

Extrapolate: It is an operation in which an element 
is extended a specified amount while respecting 
tangency or curvature conditions. Typically a 
surface boundary can be selected for in order to 
extrapolate the surface a specified length.

Extrude: It is a surface created by extruding a 
2D/3D Profile within the defined extrusion limits.
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Glossary

Feature: It is a component of a part.

Fillet: It is a curved surface of a constant or variable 
radius that is tangent to and joins two surfaces. 
Together these three surfaces form either an inner 
or outer corner.

Healing: It is a process of repairing small gaps 
between two adjacent surfaces.

Hybrid Design: It is a design approach where 
Wireframe and Surface Geometry and Part Design 
features can be created in the same body.

IGES: It is a file format named for Initial Graphics 
Exchange Specifications.

Instantiate: It is an operation of creating a new 
instance of a component or its features from same 
or different documents.

Join: It is a wireframe or surface created by joining 
adjacent wireframe or surface elements.

Load: It is an operation in which the document 
(CATPart, CATProduct, XLS) is loaded in CATIA.

Multi-Body Method: It is an approach where the 
design of a complex part is split into separate bodies 
and then the final geometry is obtained by 
performing Boolean operations on the bodies.

Multi-model link: It is a link referring to another 
part.

Multi-section Surface: It is a surface that is 
obtained by sweeping two or more planar section 
curves along a spine, which may be automatically 
computed or user-defined.

Multi-sections Solid: It is a solid created by 
computing a solid through the profiles in multiple 
planes.

Non-associativity: It is a term which represents no 
interdependent relationship between entities.

Offset surface: It is a surface that is obtained by 
offsetting an existing surface a specified distance.
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Glossary

Parent feature: It is a feature which is hierarchically 
higher in the order of relationships with other 
features.

PartBody: It is a default body created in a CATPart
Power copyis a feature created in a part which 
contains input parameters and features which can 
be duplicated in another part quickly.

Published Geometry: It is a geometry which is 
exposed and available to external users for 
selection during contextual design or applying 
constraints in an assembly.

Reflect line: It is the neutral line from which the 
draft faces will be generated in case of Reflect line 
drafts.

Representation: It is a term which describes the 
geometrical shape of the part.

Revolve: It is a surface of revolution created by 
revolving a planar profile about an axis.

Rotate: It is an operation in which an element is 
rotated by a specified angle about the given axis.

Scan: It is a process of reviewing the design of the 
model feature by feature.

Selective load: It is an operation in which the 
assembly is loaded in CATIA in stages.

Skeleton: It is a part which contains the wireframe 
geometry, specifying the design of the assembly.

Sketch: It is a set of geometric elements/profile 
created in the Sketcher workbench.

Solid Combine: It is a solid created by intersection 
of two or more extruded profiles.

Spine: It is a curve which normal planes are used to 
position a profile when creating a surface (lofted or 
swept surface for example). The profile does not 
necessarily intersect with this spine.

Split: It is a feature created by cutting existing 
elements with other geometric elements (planes, 
surfaces, etc.).
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Glossary

Visualization mode: It is a mode in which the 
lighter CGR models are loaded in CATIA for 
visualization purpose. The design features of the 
parts are not seen in this mode.

VRML: It is a file format named Virtual Reality 
Modeling Language.

Wireframe element: It is and element such as a 
point, line or curve that can be used to represent the 
outline of a 3D object.

Swept Surface: It is a surface obtained by 
sweeping a profile in planes normal to a spine curve 
while taking other user-defined parameters (such as 
guide curves and reference elements) into account.

Symmetry: It is an operation in which an element is 
transformed by means of a mirror symmetry with 
respect to a reference plane, line or point.

Synchronize: It is an operation of updating the link / 
assembly /document so that design changes done 
in parent document are propagated.

Translate: It is an operation in which an element is 
displaced along the specified direction by a specified 
distance.

Trim: It is a an operation in which wireframe or 
surface are cut mutually.

V4 model: It is a CATIA V4 model.

Vertex: It is a point where more three or more 
edges meet.
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